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INTRODUCTION

You can use the Win School® Health module to keep track of student health
information including immunizations, examinations, and conditions.

With Health, you can assign immunizations, examinations, or conditions to
individual students or to a group of students, and then report on students’
immunizations, examinations, and conditions.

Getting Help

Access the Health online Help and ToolTips for more information.
ToolTips provide more information about a button or area.

TO DISPLAY ONLINE HELP:
* From the Help menu, choose Help Topics

OR
Press F1

TO DISPLAY A TOOLTIP:

* Pause your mouse pointer over a button or area.

Ei

WS Update

Ipdate From Win School

Getting Technical Support

Chancery’s support programs are available by subscription and include the
below services.

Technical Support solves problems and answers questions when
software doesn’t produce the expected results.

Monday to Friday, 5 am to 5 pm Pacific Time
phone: 1-800-688-9939

fax: 1-800-346-0643

email: techsupp@chancery.com

website: http://support.chancery.com

Web support Chancery’s web site includes a searchable
knowledge base with frequently asked questions,
tips, and troubleshooting, as well as support
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forums for users to share experience and
knowledge. Web tutorials are available on an
annual subscription basis.

Software updates releases of new versions with improved functions
and software fixes. Updates are provided free of
charge for three months from your date of
purchase and are included in the subscription to
Chancery Support Programs.

For more information on Technical Support Programs, call Chancery
Customer Service at 1-800-999-9931 extension 130.

Providing Feedback
To improve the quality of your documentation, we would like your

comments regarding this guide. Email comments to Chancery’s User
Education department at user_docs@chancery.com.
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SETTING UP HEALTH

When you set up Health, you need to decide:
* whether to use Health in a single or multi-user environment
* where to maintain doctor information, Win School or Health
* what standards to use for Health setup information
* the schedule to update Health records
*  backup schedule

e archive schedule

Before You Start

Before you start working with Health, you must make some decisions on
how you will be using Health. Thinking through how you use Health and
setting up proper data standards at the beginning will save you a lot of extra
work in the long run.

Deciding on Single or Multi-User

Before you install Health, decide whether you will be using Health in a single
or multi-user environment.

In single-user mode, only one workstation can use Health and everything
you do in Health is done on that workstation.

In multi-user mode, many workstations are connected to the same Health
database and can use Health at the same time. Several people can change
information for the same student at the same time. Each person that clicks
OK or Save will save his/her changes to the record. When one person adds a
student, that student record is immediately available on all workstations.
However, only one person at a time can archive.

Once you have installed Health in one mode, we recommend that you do not
change from one mode to another.
TO CHANGE FROM ONE MODE TO ANOTHER:

1 Install Health 1.0 using the Release Notes that came with it. In the
installation process, specify whether you want single-user or multi-user.

2 Install the Health 1.3 Update, and any other required updates using the
Release Notes that came with those updates.

Setting Up Health
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Determining Data Standards

Before you work with Health, decide on the standards for Health
information.

Data standards establish school-wide and district-wide conventions for
setting up and entering data. Determining standards regulates terminology,
maintaining consistent spelling, abbreviations, and capitalization.

Before you start working with Health, decide on the standards for:

immunization titles, doses, reactions, populations, requirements, alternate
requirements, and provisional enrollment period

examination titles, statuses, categories, and codes

condition titles, levels, and comments

Using Unique Codes for Each School

Setting Up Health
Before You Start

If you are using only one Health database, skip this section.

If you are using multiple Health databases, you can either use the same setup
information for all databases or different setup information for each
database.

First, make a copy of the default database as a backup. Then make one copy
of the database for each school.

To use the same codes for all schools, copy the Health database file after you
set up standard immunization, conditions, and examinations.

Conversely, to use unique codes for each school, copy the Health database
file before you start.

The following diagram illustrates creating one copy of the Health database
for each school.

Health Win School

default
Data rmdh
databaze

database 3




TO CREATE COPIES OF THE HEALTH DATABASE FILE:

To use standard immunizations, examinations, and conditions for all schools,
make sure you have set up Health following established standards.

In Windows Explorer, create one folder for each school database.

In the folder where you installed Health, copy your Health database file (in
this example, it’s Data.mdb) into the folders you created in step 2.

Rename each copy of the database in each folder with a unique file name.

Scheduling Routine Tasks

Make sure there is a schedule for recurring tasks like updating Health with
Win School demographic data, backing up, and archiving,

Scheduling Win School Updates

Scheduling Back Up

Scheduling Archive

Plan the best time to populate and update Health with demographic data
from Win School. Include this as one of the regular tasks for Win School and
Health.

Before you start working with Health, you must run WS Update to populate
the database. Then, run WS Update regularly to make sure the Health
database contains the current changes made in Win School.

For more information, see “Updating Data from Win School” on page 32.

Make sure the Health data files are backed up regularly. If you use

Win School, include Health as part of your Win School backup. Check with
your System Administrator to make sure there is a schedule for backing up
Health data files.

Plan the best time to archive records. You only need to archive records when
student records have been deleted from the Win School database. For
example, your school might only delete student records at the end of the
school year.

If you work in a multi-user networked environment, plan when to archive
student records, because only one user can archive records at a time.

For more information, see “Archiving Data” on page 42.

Using Task Checklists

Use the following list of tasks to check when and what you must set up, work
with, and archive.

Setting Up Health | §
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STARTING THE SCHOOL YEAR

e set up and maintain Win School School Setup and Details
* install Health

* back up and copy the Health database file

* set up database connections

* connect to the school database

* setup user accounts

* specify where to maintain doctor information

¢ populate Health with Win School data and set up schedule to regularly
update Health with Win School data

¢ create and load a Health archive file

* establish backup and archive schedule

* set up standard immunizations, examinations, and conditions

* set up immunization requirements

* specify the provisional enrollment period and the school year start date
¢ enter student medical information

WORKING DURING THE SCHOOL YEAR

° maintain student information

* assign, change, or delete immunizations, examinations, and conditions
* update Health with Win School data regularly

* generate reports

e export data to other software

* if necessary, change database connection

FINISHING THE SCHOOL YEAR

e archive Health records in a data file
* if necessary, generate final reports

* if necessary, export data to other software

Logging On
Everyone who uses Health should have his/her own username and

password. To guard against unauthorized access to the database, make sure
users do not share usernames and passwords.

Setting Up Health
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Logging On for the First Time

You need database administrator access to log on the first time and set up
Health.

After you log on, you must change the DBAdmin password to keep the
Health database secure.

TO LOG ON TO HEALTH FOR THE FIRST TIME:

1 From the Start menu, choose Programs, choose Win School, then choose
Health.

2 In the Logon dialog, type DBAdmin in both the “Name” and “Password”
fields.

Usernames and passwords are case sensitive, so you must type uppercase and
lowercase characters correctly.

3 Click OK.

4 In the message telling you that Health is not connected to a Health database
file, click OK.

5 In the Database Connection Setup dialog, specify a Health database
connection following the procedure below.

6 Change the DBAdmin password. See “Changing Passwords” on page 11.

Logging On
If you do not know your username and password, see your System
Administrator. Do not share your username and password with others. Each
person should have his/her own username and password.

TO LOG ON TO HEALTH:

1 From the Start menu, choose Programs, choose Win School, then choose
Health.

2 In the Logon dialog, type your Username and Password.

Usernames and passwords are case sensitive, so you must type uppercase and
lowercase characters correctly.

3 Click OK.

Setting Up a Database Connection

When you log on, Health automatically connects to the last database you
selected.

The first time you log on, you must specify the database to which you want
to connect.

Setting Up Health | 7
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Setting Up Health

You can connect to another database at any time.

If you travel from school to school, you can use Health on a laptop
computer to connect to Win School databases in different schools. For more
information, see “Using a Laptop Computer to Connect to Win School
Databases” on page 10.

archives [ |
| pictures

TO SET UP A DATABASE CONNECTION:

Health data Min Schaool databaze
[zchaol name)

Min School zener
IP Addrezs

From the File menu, choose New Connection. If you are logging on for the
first time, the New Connection dialog opens automatically.

If you want to define a new connection, click Add first. If you change an
existing connection, the existing information is replaced.

You must connect to a database to continue.

In the School Name field, type the school name exactly as it is in the Win
School database. The school name is case sensitive so type upper and lower
case characters exactly.

In the Database Name field, make sure the school name is cotrect.

Type the Win School IP Address. This number uniquely identifies the Win
School Server. See your System Administrator for this information, typically
numbers and periods, such as 10.01.50.60. Type the number exactly as it
appears in the Win School server, including any leading zeros.

Type the path and file name of the Health database file.
Type the path of the archive files and the picture bitmap files.

You must name each bitmap file using the student’s number, and then store
the files in the Picture Source Directory.

If you already have student pictures for Win School that uses student
numbers as the bitmap file name, you can share the same folder for the
Health student pictures.

Setting Up a Database Connection



For example, a student named John Smith with the student number 1054682
would have a picture in the bitmap file named 1054682.bmp in
c:\winschl\health module\data\pictures.

Mew Connection - Health Module

Currently connected to

School Mame |I:han|:er_l,l Acaderny |

Wit School 1P Address: [10.01.90.20 |

Hedth Data Source Fle: |c:'\WinschI‘-.|-| ealth ModulehDratahD atalles D ata. mdb |

Archive Source Directon: |c:'\WinschI‘~J-I ealth ModulehD ata'D ataliless, |

Connect |

add | pele | o |

Ficture Source Directony:

Record: 14| ¢ |] I I

7 To enter information for another school, click Add, click Yes to save the
changes, then repeat steps 2 through 5.

To display the settings for a different school, click the left or right arrow
buttons, or specify its record number at the bottom.

8 To connect to a school, use the left or right arrow buttons to display that
school in the School Name field. Then click Connect.

Follow the onscreen instructions to complete the connection.

Make sure the top of the dialog shows the name of the school to which you
want to connect.

TO CHECK THE SCHOOL NAME IN WIN SCHOOL:
1 Start Win School. Then start School Setup.

2 From the School menu, double-click School Information.

3 From the School Information popup menu, choose Extended Information.

Connecting to a Database

You can connect to different Health databases that have been set up, in one
school or in different schools.

You can use Health on a laptop computer to connect to Win School
databases in different schools.

Setting Up Health | Q
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The procedure to connect to a Health database is the same whether you are
using a desktop or laptop computer. As long as you have set up the Health
database connection correctly, and you are on the same computer network as
the database you want, you can connect to that database.

Using a Laptop Computer to Connect to Win School Databases

If you travel from school to school, you can use Health on a laptop
computer to connect to Health databases in different schools.

TO CONNECT TO A DIFFERENT HEALTH DATABASE:

1 If you are using a laptop computer, make sure you are connected to the
school’s computer network. Then from the File menu, choose Open
Connection.

The Database Connection dialog opens showing the Current Connection
and the School Name popup menu.

2 TFrom the School Name popup menu, choose the school you want. Click
Connect.

3 TFollow the onscreen instructions to complete the connection.

Setting Up User Accounts and Passwords

Set up user accounts to guard against unauthorized access to the database.
Instruct users to contact the system administrator if they:

* forget their password

* find that their password no longer works

* suspect that others are using their password

Also instruct staff not to write down their passwords in a place where others
can see it.

It might be useful for the database administrator to keep a list of user
accounts in a secure location.

Setting Access Levels
User accounts have one of the following access levels:

* Read Only lets you view information, generate reports, and export data. You
can change your own password but you cannot make any other changes.

*  TFull Access lets you view and edit information. You can also change your
own password.

Setting Up Health
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DBA (Database Administrator) lets you view and edit information. You can
create and delete user accounts, and change user passwords. You must have
at least one DBA account.

Changing Passwords

All users can change their own password. Only users with DBA access can
change other accounts’ passwords.

TO CHANGE PASSWORD:

From the Setup menu, choose Change Password.
If you have DBA access, you can select which account password to change.

Type in the old password. Then type the new password in the New Password
and Confirm text boxes.

Click OK to confirm the password change.
Click Cancel to close the Change Password dialog,

Managing User Accounts

N~ o0 a b

-

A WO N

You must have DBA access to create, modity, or delete user accounts.

Usernames and passwords are case sensitive, for example, JoAnne is
different from Joanne.

TO CREATE USER ACCOUNTS:

From the Setup menu, choose User Accounts.
In the Setup User Accounts dialog, click Add User.

Type the Username. Then type the password in the Password and Confirm
text boxes.

Usernames and passwords must be 4-14 characters long and are case-
sensitive.

Select an Access Level radio button. Click OK.

A dialog confirms the account is created. Click OK.
To continue creating accounts, click Add User.
When you have finished, click Done.

TO DELETE USER ACCOUNTS:

From the Setup menu, choose User Accounts.
In the Setup User Accounts dialog, click Delete User.
From the popup menu, select the account you want to delete. Click OK.

A dialog asks for confirmation. Click Yes to delete that account.

Setting Up Health
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A dialog confirms the account is deleted. Click OK to return to the Setup
User Accounts dialog,

When you have finished, click Done.

TO MODIFY USER ACCOUNTS:

From the Setup menu, choose User Accounts.

In the Setup User Accounts dialog, click Modify User.

From the popup menu, select the account you want to modify. Click OK.
Select a different Access Level. Click Done.

A dialog confirms that permissions for the account is changed. Click OK.

When you have finished, click Done.

Setting Up Doctor Information Source

Setting Up Health

Decide where you want to maintain doctor information. You can enter
doctor information in either Health or Win School.

If you maintain doctor information in Win School, that information is
updated in Health when you click WS Update or choose Update from
Win School Database from the File menu.

If you maintain doctor information in Health, both doctor and dentist
information is maintained in the Student Profile. However, the doctor
information in Health may be different from that in Win School.

If you change to importing doctor information from Win School, any doctor
information presently in Health is replaced by the information in
Win School.

TO SET UP DOCTOR INFORMATION SOURCE:

From the Setup menu, choose Doctor Information Source.

To maintain doctor information in Win School, select “Imported from Win
School”.

OR

To maintain doctor information in Health, select “Maintained locally in the
Health Module”.

% Doctor Information Setup - Health Module E

" |mported from Win School

" Maintained locally in the Health Maduls

Setting Up Doctor Information Source



3 Click Done.

Setting Up Immunizations

Immunizations include any type of medication provided to students to
prevent infection.

Set up the immunizations required by State and Federal mandate, and by
your school district.

Setting up immunizations includes several phases. See the following sections
for details of each phase and how to set it up.

¢ Setting up immunization names and doses.
¢ Setting up immunization reactions.

¢ Setting up the requirements for each immunization dose, such as when each
dose must be administered.

e If your school or district uses provisional enrollment, set up the Provisional
Enrollment Period.

You do not need to set up Immunization Actions as that is already set up as
part of Health.

After you have set up immunizations, if you change any immunization name,
dose, reaction, or requirement, students will automatically have the changed
immunization name, dose, reaction, or requirement.

After you have set up immunizations, if you delete any immunization name,
dose, reaction, or requirement, students will immediately lose the deleted
immunization (and all its doses), dose, reaction, or requirement. There is no
undo.

Setting Up Immunization Titles and Doses

Set up the immunizations required by State and Federal mandate, and by
your school district.

Immunization titles are the types of immunizations given to students such as
polio and MMR.

Doses are specific doses of immunizations, such as a booster shot or one in a
series of immunization doses.

All immunization actions, for example Administered, are assigned to a dose
and not to the entire immunization. For this reason, each immunization must
have at least one dose.

Setting Up Health | 13
Setting Up Immunizations



14

TO SET UP IMMUNIZATION TITLES AND DOSES:

In the Main window, select Setup and choose Immunizations Setup.

The Immunization Setup dialog displays the Immunization Title at the top
and the doses/series for that immunization at the bottom.

In the Immunization Title area, click Add and type an immunization name.
The name appears in the text box at the bottom. Click OK.

When you add an immunization, its first dose is automatically added. Each
immunization must have at least one dose.

To change a dose name, select the dose name and type a new name.

To add a dose, click Add in the Doses area. Then type the order and the
name of the dose. Click OK.

The order is the sequence in which Health displays the doses. For example,
dose order 1 can be “infant dose 17, order 5 can be “youth booster”, and
order 12 can be “adult booster”. The doses are displayed by order sequence
and not alphabetically by name.

Follow the above step to add all doses for the displayed immunization.

% Immunization Setup - Health Module m

Title/Doses I Reaction |

Immunization Title:

IDTPfDTaP ;I

Add Edit Delete |
For the immunization above, defing the doses below:
Order Dose
1DTP/DTaF Dose 1 &

2DTP/DTaF Dose 2 —
3DTP/DTaP Dose 3
4DTP/DTaP Dose 4

Delete

Done

5 Repeat steps 2 to 4 to add other immunizations and doses.

6 When you have finished setting up immunizations and doses, click Done.

Setting Up Health
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Changing and Deleting Immunizations and Doses
Once you have set up and started using immunizations and doses, they are
assigned to student records.

If you delete a dose that is assigned to students, those students will lose that
dose. If you delete an immunization, students with that immunization will
lose that immunization, including all its doses. There is no undo and the only
way to get the information back is to restore from a backup.

TO CHANGE AN IMMUNIZATION TITLE:

1 In the Main window, select Setup and choose Immunizations Setup.

2 In the Immunization Title popup menu, choose the Immunization you want
to rename. Click Edit.

3 Type the new title and click OK.

TO DELETE AN IMMUNIZATION:

1 In the Main window, select Setup and choose Immunizations Setup.

2 In the Immunization Title popup menu, choose the Immunization you want
to delete. Click Delete.

A warning informs you that deleting an immunization deletes all its doses.
All students with that immunization will lose that immunization and all its
doses. There is no undo.

Click Yes to delete that immunization and all its doses.

TO CHANGE A DOSE NAME:

1 In the Main window, select Setup and choose Immunizations Setup.

2 In the Immunization Title popup menu, choose the Immunization you want
to work with.

3 In the Doses area, click the dose you want to change, and make changes in
the dose list.

TO DELETE A DOSE:

1 In the Main window, select Setup and choose Immunizations Setup.

2 In the Immunization Title popup menu, choose the Immunization you want
to work with.

3 In the Doses area, click the dose you want to delete, and click Delete in the
Doses area.

A dialog shows the dose you are about to delete. All students with that dose
will lose that dose. There is no undo.

4 Click Yes to delete that dose.

Setting Up Health | 15
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Setting Up Reactions to Immunizations
You can set up possible reactions to immunizations, such as allergic
reactions.

Reactions are accessible by all immunizations. Set up reactions once and you
can assign them to all immunizations.

TO ADD IMMUNIZATION REACTIONS:

1 In the Main window, choose Setup and select Immunizations Setup.
2 In the Immunization Setup dialog, click the Reaction tab.

3 Click Add and type a reaction. The reaction appears in the text box at the
bottom. Click OK.

4 To add more reactions, repeat the above step.
5 When you are done, click Done to close the Immunization Setup dialog;
Changing and Deleting Immunization Reactions

When you delete a reaction, any students with that reaction will have the
reaction reset to N/A. There is no undo for deleting a reaction.

When you change a reaction, any students with that reaction will
automatically have the edited reaction. There is no undo.

TO CHANGE OR DELETE IMMUNIZATION REACTIONS:

1 In the Main window, choose Setup and select Immunizations Setup.

2 In the Immunization Setup dialog, click the Reaction tab.

3 To change a reaction, select the reaction in the list and type a new reaction.
All students with that reaction automatically have the changed reaction.

4 To delete a reaction, click the reaction to select it and click Delete.

A dialog tells you how many students have that reaction, which will be
changed to N/A. Click Yes to confirm you want to delete that reaction.

5 Click Done to close the Immunization Setup dialog.

Setting Up Immunization Requirements
After you set up an immunization requirement, Health checks the student’s
birthdate or current grade to determine which immunization doses the
student should have received.

Populations are groups of students who must have received an
immunization. Populations can be based on age or grade. For clarity, use the
student group as the population title, for example, “Grade 2-3” or “5-6
years.”

4 6 | Setting Up Health
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You must set up populations to cover the entire student age range, and
populations must not overlap.

Students must be in a population to have immunization requirements and to
show up in reports. For example, if there is no population for 3—4 year-olds,
then you cannot assign any immunization requirements to this age group,
and they will not be in any Health reports.

In addition to defining the age or grade range for a population, you can also
define the following:

*  which immunizations and doses need to be administered
* minimum age when a dose must have been received

* whether a previous dose must be administered first

* the time period between doses in an immunization

* whether a dose must be administered within a time period, for example, if a
dose must have been received within the last year

 alternate immunization, if an immunization can be replaced by another, such
as using the measles vaccine as an alternate for MMR

For example, for the 5-6 year-old age range, students must have received 4
doses of DTP/DTaP, 3 doses of Polio, and 1 dose of MMR. You can set up a
population called “5-6 years” with those immunization doses.

The chart below is an example of the populations you can set up with the
required doses for that population (age range.)

Population Polio dose 1 Polio dose 2 Hib - Child Hib - Adult
5 - 6 years v v
7 - 11 years 4 v 4

Health checks that the series of individual doses have been administered, not
just the number of doses. For example, Health checks that a student has
received dose 1 and dose 2, and not dose 1 twice.

To set up immunization requirements, first set up populations, then set up

the immunization requirements for each of the populations.

Mapping Out Immunization Populations and Requirements
Before you set up immunization requirements, map out each population and
every immunization dose each population needs.

You must be absolutely certain of the following:
*  You have populations to cover all ages or grades.

Students that are not in any population cannot have immunization
requirements assigned to them and will not show up in any report.
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* None of the immunization requirements conflict with another.

If there are conflicting immunization requirements, including alternate

requirements, reports and provisional enrollment calculation might be

incorrect and you cannot tell which requirement is used.

Setting Up Populations and Requirements

Set up both populations and immunization requirements in the same dialog,

For faster performance, set up only the populations you use.

Never overlap populations. For instance, if the range for population 1 is ages
5-10, do not make population 2 for ages 7—12.

TO SET UP POPULATIONS:

1 In the Main window, select Setup and choose Immunization Requirements.

The Immunization Requirements dialog shows Populations on the left and
the Immunization Requirements for that population on the right.

At the bottom are descriptions of the population and the requirement.

The arrow to the left of a line indicates you are working with that population
and requirement. Click on a different line to work on another population or
requirement. The description at the bottom changes when you select a

different population or requirement.

The asterisk besides a dose indicates that there is an alternate for that dose.

% Immunization Requirements - Health Module m

— Populations

— Immunization Requirements

12 - 14 manths - Paopulatian: 12 vears and alder
12 years and older Immunization Dozes
15 months - 17 months OTPIDTaF 3
18 months - 4 years 4 oo B A 3 =
2 - 3 months e
Measles 2 X
2 months or younger TR .
4 - 5 months - T
5 5 peas | Polio 3 |
L4 h arinella 1 hd
Add Edit Delete | Add Edit Delete | Altermate |
— Population description — Immunization requirement description : DTR/DTaF

Age is at least 12 years old.

the last 10 vear(s).

DTRIDTaP Dose 1 required at any time. within

DTRIDTaP Dose 2 reguired after previous

Done |

2 To add a population, click Add in the Populations area.
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3 In the Population Setup dialog, type a Population Name. Then define the age
or grade range of that population.

Population Setup - Health Module

Population Mame: |1 2 -14 monthg

— Population Description

* Ageis at least I‘I2

Imonths;l and under IT Imonths vl

Iunder

 Grade iz at lzast

I - | up ta and including I - |

;I I I_l,lears ;I

 Grade is I

1l [

ak. | Cancel

Population Description

Age is at least ... months/
years and under ...
months/years

Age is under/at least ...
months/years

Grade is at least ... up to
and including ...

Grade is under/up to and
including ...

Meaning

The population’s age must be equal to or over the
lower age, and less than the higher age.

In this example, the age range is 12 - 14 months,
inclusive. For a population of 4 year-olds, you would
define it as Age is at least 4 years and under 5 years.

“Under” means less than the age. “At least” means
equal to or over the age.

The population’s grade must be equal to or over the
lower grade, and less than or equal to the higher grade.

“Under” means less than the grade. “Up to and
including” means less than or equal to the grade.

4 Click OK to return to the Immunization Requirements dialog.

5 Repeat steps 2 - 4 to set up another population. Make sure you have

populations to cover all ages or grades. When you’ve finished, click Done.

You can set up all populations and then set up immunization requirements
for each population. Or you can set up the requirements for the population
you have set up using the following procedure.

All students must be in a population to have immunization requirements and

to appear in immunization reports.

TO SET UP IMMUNIZATION REQUIREMENTS:

1 If you are already in the Immunization Requirements dialog, go to the next
step. Otherwise, in the Main window, select Setup and choose Immunization

Requirements.
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The arrow to the left of a line indicates you are working with that population
and requirement. Click on a different line to work on another population or
requirement. The description at the bottom changes when you select a
different population or requirement.

Click a population to work with it. The arrow to the left of the population
shows it is selected.

In the Immunization Requirements area, click Add.

The Immunization Requirements dialog shows the Population name at the
top.

From the Immunization popup menu, choose an immunization that is
required for this population.

When you select an immunization, all the doses for that immunization are
displayed in the Dose Requirement area.

B Immunization Aequirements - Health Module

Fopulation:  ear 7 IHep B

— Dioge Requirement

Doze [ Requirement | Minimum Age | Age Units
| |HepB Dosel At any time 0 pears
| |HepB Dose 2 After previous doge 0 yearz
F |Hep B Doze 3 Alter previous doze 0 pears

— General Regquirements

[v  Dosesin series must be received at lzast IEID daylz] apart.

[  &tleast one dose must have been recersed within the last |2 year[z].

™ Atleast one dose must be received on or after the minimurn age of IEI Imonths - |

Cancel |

The icon at the left of a dose indicates you are working with that dose. Select
a dose, then click on the requirement to choose a requirement from the
popup menu:

If a dose: Choose:

Can be administered anytime At any time

Must be administered after the After previous dose

previous dose

Must be administered after a Use minimum age. Then specify the
certain age minimum age and select years or

months in the Age Units column.

Is not required for this Not required
population



6 In the General Requirements area, specify conditions for doses.

If doses cannot be administered too close together, select the “Doses in
series must be received at least” checkbox and specify the number of days
between doses. This only applies if the requirement is “After previous dose”.

If a dose (usually the latest one) must not have been received too long ago,
select the “A dose must have been received within the last” checkbox and
specify the number of years.

If a dose must be received on or after a minimum age, select the “Atleast one
dose must be received on or after the minimum age of”” checkbox and
specify the age.

7 Click OK.

8 Continue to set up immunization requirements for that population. If two
populations have the same requirements, set up the same immunization
requirements for each population.

An immunization requirements must not conflict with another. Otherwise
you won’t know which requirement is used for reports and provisional
enrollment calculation.

9 When you have finished, click Done.

Changing and Deleting Populations and Requirements
If you change a population, students that meet the new population criteria
will belong to the new population.

If you delete a population, all the requirements for that population will also
be deleted. There is no undo.

If you change or delete a population, make sure all students still belong to a
population so that they can be assigned immunization requirements.

If you delete an immunization requirement, that requirement is deleted from
that population. There is no undo.

If you change an immunization requirement, students with that requirement
will immediately be assigned the new requirement and provisional
enrollment is recalculated for that population.

TO CHANGE OR DELETE POPULATIONS OR IMMUNIZATION
REQUIREMENTS:
1 In the Main window, select Setup and choose Immunization Requirements.

2 To change a population, select the population and click Edit in the
Populations area.

In the Population Setup dialog, change the population title and/or
description. Then click OK.
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To change an immunization requirement, select the population on the left,
then select the immunization on the right. Click Edit in the Immunization
Requirements area.

In the Immunization Requirements dialog, make changes. Click OK.
To delete a population, select the population and click Delete.

A dialog tells you how many rules are defined for this population. Click Yes
to confirm deleting this population. There is no undo.

To delete an immunization requirement, select the population on the left,
then select the immunization on the right. Click Delete in the Immunization
Requirements area.

A dialog tells you which requirement for which population you are about to
delete. Click Yes to confirm deleting this requirement for this population.
There is no undo.

Click Done to close the Immunization Requirements dialog,

Setting Up Alternate Immunization Requirements

Setting Up Health
Setting Up Immunizations

Some immunizations may be accepted as a substitute for another. For
example, MMR might be accepted as an alternate to the measles vaccine.

The asterisk besides a dose indicates that there is an alternate for that dose.

Make sure alternate immunization requirements do not conflict with each
other. Otherwise you won’t know which requirement is used for reports and
provisional enrollment calculation.

TO SET UP ALTERNATE IMMUNIZATIONS:

In the Main window, select Setup and choose Immunization Requirements.



2 Select the population and the immunization you want to work with, so that
the arrows point to the correct population and immunization.

Immunization Requirements - Health Module

— Populations — Immunization Requirements
10-14 A Population: 12 years and older
12 - 14 morths .
— Immunization Doses
p 12 years and older OTPDTaP 3
15 maonths - 17 months Ten B a 3 -~
18 months - 4 pears MED I 2 P2
2 - 3 months b |Measies
MMR 1
2 months or younger -
4 - B months | Palio 3 |
hd arinalla 1 hd
Add Edit Delete | Add Edit Delete |
— Population description — Immunization requirement dezcription : I easl
Age iz at least 12 years old. Measles Dose 1 required at any time. -
Measles Dose 2 required after previous dose. -

3 In the Immunization Requirements area, click Alternate.

The Alternate Requirements dialog lists all the alternate immunizations for
that immunization.

Altemale Requirements - Health Module

FPopulation: 7 - 11 years Immunization:  Measles

— Requirements

Original Doze Alternate Doze
Measles Doze 1 MR "
Measles Dose 2 kA
-
e Delete

— Alternate Requirement Description

Dozes MMB Dose 2 required on or after the kids tun 1 pears

Dane |

4 In the Alternate Requirements dialog, click New to display the Alternate
Requirements Wizard.

The Alternate Requirements Wizard is a series of dialogs to assist you in
setting up an alternate immunization.
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The first screen of the Alternate Requirements Wizard shows the population
and immunization you have selected.

Eahllemale Regquirements Wizard - Health Module

Inthe 3 soreens of this wizard, pou will define an altemnate way students can fulfil an immunization
requirememt,

Population: 12 years and older

Immunization :  Measles

Select the doselz] for this immunization which can be replaced by an altemate requirement:

™ Measles Dose 1 receive at any time years

™ Measles Dose 2 receive after previous dose 0 days

Click Mest to define an alternate requirement which can replace the selected dose(s)

Cancel | < Biach Fiieh |

5 Select the dose(s) that can be replaced by an alternate immunization. Then
click Next.

6 In the second screen, select an alternate immunization, dose, and
requirement. Click Next.

E3 Alternate Requirements Wizard - Health Module

Set up an alternate requirement ta replace the fallowing dose requirements:

TETAMUS Doge 2 received at any time

Alternate Immunization: IV.-’-'A.FHI:ELL.*-“« j
Alternate Dose Beguirement
Doze Requirement
I‘-I.-’-‘«FEIEE LLA Dose 2 d Iuse minimum age d of |2 I_I,Jears d
Cancel | < Back | MHext > | Eitirety |

7 'The final screen of the Alternate Requirements Wizard summarizes your
selections, including:

* population for this immunization
* original immunization and dose(s)

* replacement immunization and dose
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If you need to change a selection, click Back and make changes. If everything
is correct, click Finish to return to the Alternate Requirements dialog, which
lists the population, original dose, alternate dose, and a description of the
alternate dose requirements.

Once an alternate requirement is defined, you cannot change it. You must

delete it and define a new alternate requirement.

Deleting Alternate Immunization Requirements
If you delete an alternate immunization requirement, that alternate
requirement is deleted from that immunization for that population. There is
no undo.

You cannot change an alternate immunization requirement. You must delete
it and define a new alternate requirement.

TO DELETE AN ALTERNATE IMMUNIZATION:

1 In the Main window, select Setup and choose Immunization Requirements.

2 Select the population and the immunization you want to work with, so that
the arrows point to the correct population and immunization.

3 In the Immunization Requirements area, click Alternate.

4 In the Alternate Requirements dialog, select the dose you want to delete.
Then click Delete.

5 Click Yes to confirm the deletion. There is no undo.

6 Click Done to close the dialog.

Setting Up Provisional Enrollment Period

A student is provisionally enrolled when that student has not fulfilled all
immunization requirements.

If a student does not have the required immunizations, that student is
provisionally enrolled for the Provisional Enrollment Period.

After the provisional enrollment period, the student appears in the
Immunization History report as Delinquent.

Set the Provisional Enrollment Period and the school year start date so
Health can calculate which students are provisionally enrolled and which are
delinquent.

TO SET UP PROVISIONAL ENROLLMENT PERIOD:

1 In the Main window, choose Provisional Enrollment Period from the Setup
menu.

2 In the Provisional Enrollment Period text box, type the number of days.

3 In the Start of School Year text box, enter the first day of the school year.
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Click OK.

Calculating Provisional Enroliment Date

Students who do not meet all immunization requirements assigned to them
are provisionally enrolled until they receive all required immunization doses.

A student is provisionally enrolled on the day an immunization dose is
overdue or on the first day of the school year, whichever is later.

For example, if a dose is required by Jack’s gh birthday on Oct. 1, Jack would
be provisionally enrolled on the day the dose is overdue — Oct. 2. Jack would
be provisionally enrolled for the provisional enrollment period or until he
receives the immunization.

Another example is a dose that is required by Jill’s 7th birthday on July 1, or
the start of Grade 2 on Sep. 1. In this example, Health uses the latter date for
Provisional Enrollment calculation and Jill would be provisionally enrolled
on the first day of school on Sep. 1.

If a student is missing multiple doses, Health calculates provisional
enrollment from the first missing dose. For example, if Joe misses a Polio
dose on Nov. 1 and then misses an MMR dose on Dec. 1, Joe’s provisional
enrollment date would be calculated from the first overdue date — Now. 2.

B Immunization Requirements - Health Module

Fopulation:  “ear: 7 IHep B

— Doze Requirerment

Dose | Requirement | Minimum Age | Age Units
| |HepB Dose1 Al arw hime 0 yearz
| |HepB Dose2 After previous doze 0 yearz
P |Hep B Dose 3 After previous doze 0 yearz

— General Bequirements

¥ Dozesin senes must be received at least IEIEI day(z] apart.

[ &tleast one dose must have been received within the last |2 vears).

I &tleast one dose must be received on or after the minimum age of IEI Imunths - I

Cancel |
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When Provisional

Immunization Requirement Situation Enrollment Begins
At any time Not received Start of school year
After previous dose Not received Start of school year



When Provisional
Immunization Requirement Situation Enrollment Begins

Use minimum age Not received, or Start of school year
received too eatly

Doses in series must be Not received, or Start of school year

received at least 7 day(s) apart received too eatly

At least one dose must have Not received Start of school year, or # years
been received within the last # within the last # after previous dose was
yeat(s) years received, whichever is later

At least one dose must be Not received, or Start of school year

received on or after the received too eatly

minimum age of 7.

Listing Provisional Enroliment Requirements
Use the Provisional Enrollment Requirements report to list the Provisional
Enrollment rules in effect.

TO VIEW OR PRINT PROVISIONAL ENROLLMENT REQUIREMENTS:

1 Click Reports and choose Provisional Enrollment Requirements.

d

Reparts

OR
From the Reports menu, choose Provisional Enrollment Requirements.

2 In the Provisional Enrollment Requirements Report dialog, select the
population and print range options.

To display the report, click View Report at the top.
To print the report, click Print Report.

To save the report as a file, click Write to File, and specity the file format,
name, and location.

3 When you have finished running the report, click Close.

For information on overriding provisional enrollment status, see
“Overriding Provisional Enrollment Status” on page 53.

Assigning Required Immunizations to Students (Batch Assign)
An efficient method is to pre-assign all required immunizations to all
students with a blank date and N/A in the Action. Then you can run a
report and see at a glance which student needs which immunizations.

As part of setting up immunizations, select the students and batch assign
tequited immunizations to them with the Action of N/A and a blank Date.
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When you administer an immunization, specify the date and select
Administered for the Action. Health overwrites records with the same
immunization and dose with the new date and action.

TO BATCH ASSIGN AN IMMUNIZATION WITHOUT A DATE AND AN ACTION
OF N/A:

1 If you want, sort the students by clicking the column heading in the Main
window.

2 Select the students to be assigned an immunization.

For information on sorting and selecting students, see “Viewing and
Selecting Student Records™ on page 46.

3 Click Batch Assign. Then click Immunizations.

i

Batch Azzign

OR

From the Edit menu, select Batch Assign Immunization.
4 From the popup menus, select the Immunization, then select the Dose.

5 Make sure Action is N/A and delete the Date.

Immunization Batch Assignments - Health Module

Select the Immunization pou want to assign to zelected students

Immnization: [Pl ]
Dose: IF'oIio Dose | |
fiction [ ]
Date: I

Comments

Optiohz
’7 ¥ Dom't add immonization if it's already assigned with this date

Azzigh | Dane |

6 Click Assign to begin assigning the immunization to the selected students.

7 A dialog shows how many students will be assigned that immunization. Click
Yes to accept the batch assign.
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When you administer an immunization, assign the same dose to the same
students using the immunization date and an Action of Administered. For
more information, see “Assigning an Immunization to Many Students” on
page 57.

Using Immunization Actions
Immunization Actions is part of Health and cannot be changed.

All immunizations must have an action. If you assign an immunization
before it is administered, use N/A as the action.

When students receive an immunization, change the action to Administered.

Exemptions are for students who do not need to receive an immunization or
a dose.

Immunization Actions include:
° N/A
*  Administered
¢ Illness exemption
*  Medical Exemption
* Military Exemption
e Parental Exemption
* Religious Exemption

For information on exempting one student, see “Viewing or Updating
Student Immunizations” on page 59. For information on exempting many
students, see “Assigning an Immunization to Many Students” on page 57.

Setting Up Examinations

Examinations include any type of review of a student’s physical or emotional
condition, including screenings.

An examination can include any type of:
* health screening, such as vision or spinal screening
e review of a student’s physical status
° review of a student’s emotional status
* examination because the student is complaining of an ailment

* impromptu examination because of other conditions or immunizations

Setting Up Health | 290
Setting Up Examinations



The Examinations Setup dialog is divided into four areas:
°  Examination Title
°  Examination Status
* Examination Category
*  Examination Code
TO SET UP EXAMINATIONS:
1 In the Main window, select Setup and choose Examinations Setup.

2 In the Examination Title area, click Add and type an Examination Title into
the text box. Click Done.

3 To add an Examination Status for the selected Examination Title, click Add
in the Examination Status area and type a status in the text box. Click Done.

Repeat to add more statuses to the selected Examination Title.

4 To add an Examination Category for the selected Examination Title, click
Add in the Examination Category area and type a category in the text box.
Click Done.

Repeat to add more categories to the selected Examination Title.

5 To add an Examination Code for the selected Examination Category, click
Add in the Examination Code area and type a code in the text box. Click
Done.

The Examination Codes you see only apply to the selected Examination
Category.

Repeat to add more codes to the selected Examination Category.
6 Repeat steps 2 - 5 to add examinations.
7 When you’ve finished, click Done.
Deleting Examinations

Once you have set up and start using examinations, they are assigned to
student records.

If you delete an examination, students with that examination will lose that
examination. If you delete an examination title, all its associated statuses,
categories, and codes are also deleted. If you delete an examination category,
all its codes are deleted. There is no undo.

You cannot change an examination. You must delete it and define a new
examination.

30 | Setting Up Health
Setting Up Examinations



TO DELETE AN EXAMINATION:
In the Main window, select Setup and choose Examinations Setup.
To delete an examination title, select the title and click Delete in the

Examination Title area. All the statuses, categories, and codes for that
examination are deleted.

To delete an examination status, select the status and click Delete in the
Examination Status area.

To delete an examination category, select the category and click Delete in the
Examination Category area. All the codes for that category are deleted.

To delete an examination code, select the code and click Delete in the
Examination Code area.

When you’ve finished, click Done.

Setting Up Conditions

-

a A WO N

Conditions are any type of physical or emotional incident or circumstance
not covered by immunizations or examinations.

You can use conditions to keep track of:

any medical conditions or incidents

medications given

actions taken

connections to other conditions, immunizations, or examinations

For example, you can use conditions to keep track of accidents or persistent
complaints from students in a part of the school.

Once you have set up and start using conditions, they are assigned to student
records.

If you delete a condition, students with that condition will lose that
condition. There is no undo.

You cannot change a condition. You must delete it and define a new
condition.

ToO SET UP CONDITION TITLES:

In the Main window, choose Health Condition Title from the Setup menu.
To add a condition, click Add and type a Condition title. Click OK.

To delete a condition, select a condition and click Delete.

Select a condition to be the default.

When you’ve finished, click Done.
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TO SET UP CONDITION LEVELS:

In the Main window, choose Health Condition Level from the Setup menu.
To add a condition level, click Add and type a Condition level. Click OK.
To delete a condition level, select a condition and click Delete.

Select a condition level to be the default.

When you’ve finished, click Done.

TO SET UP CONDITION COMMENTS:

In the Main window, choose Health Condition Comment from the Setup
menu.

To add a comment, click Add and type a comment. Click OK.
To delete 2 comment, select 2 comment and click Delete.
Select 2 comment to be the default.

When you’ve finished, click Done.

Using Health with Win School

When you use Health with Win School, some factors can help you work
more effectively with the two programs:

Do not change first or last student names in Win School. To ensure that
student data is consistent and that health information is not assigned to the
wrong student, Health checks that the student’s first and last name are the
same before updating demographic information into Health.

In Win School, after you run Next Year Prep and before you run
Current/Next Year Merge, add students in the same order in both the
current year and next year databases.

Updating Data from Win School

Setting Up Health

Set up a schedule to regularly update the Health database with Win School
demographic data. This will ensure you are working with current Win School
data. Win School does not automatically update Health.

If you are updating a large number of students, the data transfer might take
some time.

If you are using a modem, data transfers take longer.
Contact your System Administrator for the update schedule.

When you run WS Update, if Health finds that the data may be inconsistent
between Win School and Health, Health may not run WS Update. For more
information, see “What to do When a Student’s Name Changes” on page 34.
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TO UPDATE HEALTH WITH WIN SCHOOL DATA:

Make sure you are connected to the correct Health database. From the File
menu, choose Open Connection.

In the Main window, click WS Update.

£

WS Lpdate

OR
From the File menu, choose Update from Win School Database.

In the confirmation dialog that appears, click Yes to update your Health
database.

The Data Transfer Status dialog shows update progress. Updating a database
with many students may be a lengthy process.

When the update is complete, check the Data Transfer Status dialog for
results of the update, then click OK to close the dialog;

Maintaining Doctor Information

When you set up Health, you specified where to maintain doctor
information: Win School or Health.

If you maintain doctor information in Win School, that information is
updated in Health when you run WS Update. You can view but cannot
change doctor information in Health.

If you maintain doctor information in Health, you can edit that information
in Health. However, that information may be different from what is in
Win School.

For more information, see “Setting Up Doctor Information Source” on
page 12.

Differences Between Health and Win School

Some student information is maintained in Win School. When you run W§
Update, that information is updated in Health. That is why it is important to
run WS Update regularly to be sure student information in Health is current.

Most student demographic information is maintained in Win School. That
information can be viewed, but not changed, in Health.

INFORMATION THAT IS MAINTAINED IN WIN SCHOOL INCLUDES:

Doctor Information (if you chose to maintain it in Win School and not
Health)

Student Disability
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Call Ambulance

Call Doctor

Can Treat

Legal Alert

Win School Medical Alert and comments

Student demographic and personal information such as name, address,
phone number, student number, medicare number, social security number,
and so on.

All contact information including Contact 1 - 4 and Emergency Contact 1
and 2.

INFORMATION THAT IS MAINTAINED IN HEALTH INCLUDES:

Doctor Information if you chose to maintain it in Health and not
Win School

Health user accounts and passwords
Health Medical Alert and comments

Student immunization, examination, and health condition information

Using Health with Different Win School Databases

You can use Health on a laptop computer to connect to Win School
databases in different schools. For more information, see “Using a Laptop
Computer to Connect to Win School Databases” on page 10.

What to do When a Student’s Name Changes

34 | Setting Up Health

If you change a student’s name in Win School, Health will update
information to a student with a different name. This ensures data
consistency so that health information is not assigned to the wrong student.

Normally, student information is consistent in Win School and in Health.
Occasionally, student information may become different. For example, if you
run Next Year Prep and then add students in a different order in the Current
Year and Next Year databases. Another scenario is if you connect to the
wrong database or an old database, such as using a laptop computer and
mistakenly connects to the wrong database.

During WS Update, Health checks the student first and last name against an
internal ID. These must be identical for WS Update to proceed. WS Update
displays a dialog where you can confirm if:

you changed a student’s first or last name in Win School

you added students in a different order in the Current Year and Next Year
databases between Next Year Prep and Current/Next Year Merge in Win
School
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When you run WS Update, if Health finds inconsistent data, you see the
Resolve Update Conflicts dialog where you can do one of three things:

* update simple name changes
* find out about incorrect name changes
 flag inconsistent records for archive

In this example, you can see that these are name changes because the Health
Student ID numbers are consistent in both Health and Win School.

B3 Resolve Update Conflicts |
The follawing students have different hames in the Win School and Health databases.

For name changes: click OK to update the current name in the Health databasze with the updated name from Win School.

0OR

For incornect names: click Cancel to keep the current name in the Health database. You must correct the namelz)] in in Schoal
before updating the Health database again.

0OR

If gtudent names don't match because they are for different students, see your Health Guide for information on archiving.

Health Student ID Current Hame in Health Database WS Student 1D Updated MName from %in Schoal Flag faor archive
1 Mizhael dbrosimoff 1 ull of [l s
10 Rozemary Bridges 10 Rosemarie Eridges [l
24 Dianne Durrant 24 Dianne Duran [l

aK Cancel

TO UPDATE NAMES IN HEALTH:
* Click OK. Health will update the name(s).

TO CORRECT INCORRECT NAMES:

¢ Click Cancel, correct the names in Win School, then run WS Update again.
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B Resolve Update Conflicts

The following students have different names in the Win School and Health databazes.
For name changes: click OK to update the current name in the Health database with the updated name from *fin School.

oR

For incomrect names: click Cancel to keep the current name in the Health database. Yiou must correct the name(z] in win School
befare updating the Health databasze again.

aoR

If ztudent names don't match because they are for different students, see your Health Guide for information on archiving.

In this example, you can see that these are different students. In this case,
you will flag the inconsistent records for archive here. For information on
archiving, see “Archiving Data” on page 42.

Health Student [0 Current Mame in Health Databaze WS Student ID Updated Mame from i Schoal Flag for archive
9 Monica Bernard 86 Rene Temple [ -
45 Colleen Lee 9 tonica Bermard [
86 Fene Temple 45 Colleen Lee [#]

(] Cancel

Setting Up Health

TO FLAG THE INCONSISTENT RECORDS FOR ARCHIVE:

Select “Flag for archive”, then click OK

Export the students records that are flagged for archive. Use a filter to
export only those records with inconsistent data. If you don’t need to keep

these students’ immunizations, examinations, or conditions, you can skip this
step. For more information, see “Exporting Data” on page 40.

Archive the student records that has been flagged for archive. For more
information, see “Archiving Data” on page 42.

Once the inconsistent records are archived, run WS Update.

Run WS Update to download the latest information from Win School. For
more information, see “Updating Data from Win School” on page 32.

Import the data from the above step into Health. For more information, see
“Importing Data” on page 37.

Using Health with Win School



Importing Data

If you have been using other software to maintain health records, you can
import the records into Health.

To import data into Health, use one of the templates supplied with Health,
making sure you must meet all the following criteria:

 all student names and student numbers must be already in Health

* all fields, including names, titles, doses, and codes, must match what you have
set up in Health

* upper and lower case text must match
* you cannot import from an older version of Health

* the import file must be formatted according to the next section: “Formatting
Files to Import into Health”.
TO IMPORT DATA FROM OTHER SOFTWARE:

1 In the other software program, export your data to a text file.

2 Convert the text file format using the file templates in the next section:
“Formatting Files to Import into Health”.

3 From the File menu, choose Import Data, then choose the type of records to
import.

4 Click OK.

Formatting Files to Import into Health
To import data from other software into Health, use one of the templates
supplied with Health. You can also format the import file according to the
following file templates, making sure you follow all the criteria in the
previous section.

Each template contains a series of fields. Format your data to match the
sequence and composition of these fields.

You must enter a carriage return as the last line of each template.

For more information, see “Appendix B: Importing Files into Health” on
page 82 for file formats. If your files match the format of exported files, they
can be imported properly.

If there are errors in the import, check the errors in c:\ImportErrors.txt,
correct them, and import again.

Setting Up Health | 37
Importing Data



38

Health Demographic Records File Template

To import demographic records, you must meet all the following criteria:
Make sure student last names and numbers are already in Health
Name the import file c:\\Import_Demographics.txt

Type only numbers in the Student Number field and only text in all other
fields

Do not use single or double quotes or apostrophes in student demographics.
For example, do not use quotation marks for abbreviations for feet and
inches, or in names such as O’Reily. For student height, use ft and in as the
abbreviations.

Because student names and numbers must already be in Health, importing
overwrites the matching records with the imported information without

further warning. The import does not add demographic records to your
Health database.

Enclose the fields in double quotes following the template below:

"StudentNumber","LastName","MedicareNumber","Height","Weight",
"MedicalAlertCondition","MedicalAlertComments' carriage return

For example:

"12345" "Latimer","123456789" "5 ft 11 in","185 Ibs" " This Student has
Diabetes","Hospital of Preference : Surrey"

Immunization Records File Template

Setting Up Health
Importing Data

To import immunization records, you must meet all the following criteria:

Make sure student last names, student numbers, and immunization titles are
already in Health

Name the file c:\Import_Immunizations.txt

Type only numbers in the Student Number field and only text in all other
tields

Enclose the fields in double quotes following the template below:
The following is the template for immunization records:

"StudentNumber","LastName","ImmunizationTitle","ImmunizationDose",
"DateofImmunization","ImmunizationAction","ImmunizationReaction",
"ImmunizationNotes"carriage return

For example:

"12345" "Latimer","Hep A","Dose 1","7/25/99"," Administered","Rashes",
"Assigned during Batch Update"



Health Condition Records File Template
To import condition records, you must meet all the following criteria:

* Name the file c:\Import_Conditions.txt

*  Make sure student last names, student numbers, condition descriptions, and
condition levels are already in Health

* Type only numbers in the Student Number field, and only text in all other
tields

* Enclose the fields in double quotes following the template below
The following is the template for condition records:

"StudentNumber","LastName"," ConditionDescription",
ConditionLevelDescription,"DateRecorded"," 1stCommentText",
"2ndCommentText","3rdCommentText","4thCommentText",
"Nurse's Comments' carriage return

For example:

"12345" "Latimer"," Asthma",Severe,"25/07/99""PE. Exempt"," Avoid
grasses, pollen","Call Doctot","N/A","Uses Inhalet" !

Examination Records File Template
To import examination records, you must meet all the following criteria:

* Name the file c:\Import_Examinations.txt

°  Make sure student last names, student numbers, examination titles,
examination statuses, examination categories, and examination codes are

already in Health

¢ Type only numbers in the Student Number and Age at time of exam fields,
and only text in all other fields

* Enclose the fields in double quotes following the template below
The following is the template for examination records:

"StudentNumber","LastName" ExamRecordIndex,"ExamDate",
Age at time of exam,"Grade at time of exam","ExamTitle"," ExamStatus",
"CategoryTitle","ExamCodeTitle"."ExamComment"carriage return

For example:

"12345" "Latimer",1,"28/07/99",15,"09","Physical Examination","Good",
"Heart"," ","Involved in active sports"

"12345" "Latimer",1,"28/07/99",15,"09","Physical Examination","Good",
Lungs","Clear","Starting to smoke"

u12345u’"Latimer"’1’"28/07/99H’1 5,"09","Ph}75ical Examination","(}ood"’
"Blood Pressure","180"," "J
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Exporting Data

You can export Health data to other software, such as Excel, to create your
Own reports.

If you are exporting from one Health database to be imported into another
Health database, the versions of Health must be the same. For reliable
results, use one of the templates supplied with Health.

Each template can contain one or more sets of filter criteria. For better
results, use a pre-defined template.

For full details on the format of exported files, see “Appendix C: Exporting
Files from Health” on page 84.

Creating an ASCII File

Setting Up Health
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You can export Health data as an ASCII file. To ensure successful import
and export of ASCII files, do not use apostrophes, single- or double-quotes
as abbreviation for feet and inches.

TO CREATE AN ASCII FILE TEMPLATE:
From the File menu, choose Export Data, then choose ASCII Transfer.

Click New Template.

Type the name of your template, then click the type of Health information
you want to include: Immunizations, Examinations, Conditions, or
Demographics.

Select a field category, select a field palette, then click Add.

Field Categories 4] Field Palette
Health Demographic Data “Student Mumber
Local Doctor Information Can Treat
=tudent Demagraphic Information | Can Call Ambulance

If you want, select additional field categories and field palettes, clicking Add
after each selection.

You must include the Student Number field in your template.

Template Fields Type | size
1 Student Humber Text 15
2 Firstname Text a0
3 Surname Text a0

6 Click Save Template, type any notes you want, then click Save.



The template is automatically saved in the Health Datafiles folder.

Ternplate Marme ; |Sept99 |

Template Type |Immunizatinns |

MHotes doctor and contact information
Created By . DBAdmin Date : 19-Aug-99
7 Click OK.

8 Click Load Template, select the appropriate template, then click Load
Template again.

TO CHOOSE WHICH RECORDS APPEAR IN THE TEMPLATE:

1 To constrain your output to a particular subset of records, click Filter
Criteria.

2 Select a field category, then select field palettes, and click Add.

3 Type the criteria. Either place double quotes or no quotes around text fields
— you cannot use single quotes.

4 Click Save Template, type a name and any notes you want, then click Save,
and click OK.

5 To preview the data file, click View Subset.
6 To close the view, click the Close box.

TO EXPORT AN ASCII FILE:
1 From the File menu, choose Export Data, then choose ASCII Transfer.

2 If you have a template you want to use, click Load Template, then select the
template and click Load Template.

3 Click ASCII Export.
4 A dialog shows you the name and location of the ASCII file. Click OK.

5 Close the window.

Exporting to dBase

TO EXPORT TO DBASE:
1 From the File menu, choose Export Data, then choose Export dBase (.dbf).

2 A dialog shows you the location of the exported file(s). Click OK.
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Exporting to Access

Exporting to Access creates the HealthExport.mdb database with six tables:
LDOIN_LocalDoctorInformationExport
DEIN_DentistInformationExport
HDDA_HealthDemographicDataExport
IMDA_ImmunizationDataExport

EXRE_ExaminationRecordsExport

HCOD_HealthConditionsExport

TO EXPORT TO ACCESS:

From the File menu, choose Export Data, then choose Export Access

(.mdb).
A dialog shows you the name and location of the exported file. Click OK.
To use the database, import it into Access.

TO USE THE ACCESS DATABASE:

Launch Access and create a blank Access database.

From the Access main menu, choose File, then choose Get External Data,
and choose Import.

Select the HealthExport.mdb database and click Import.
There are six tables as listed above. Click Select All, then click OK.

Exporting to Excel

TO EXPORT TO EXCEL:

From the File menu, choose Export Data, then choose Export Excel (.xls).

2 A dialog shows you the name and location of the exported file. Click OK.

Archiving Data

Setting Up Health
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At the start of the school year, you might want to create a file you can use
throughout the year to archive student records.

At the end of the school year, you might want to generate reports or export
data. Also, create an archive of the records you have flagged for archive.

Archiving is a one-way process. Once records are archived, you can view but
cannot edit those records again. You cannot bring records back from an
archive.



Creating an Archive File

At the start of the school year, create a file you can use throughout the year
to archive student records.

If you use Health in multi-user mode, you must create the archive file on a
network drive that all users can access. If you archive students onto a local
drive, then other users would only be able to see the name of the archive file,
but would not be able to read the information in it.

Student records are flagged for archive when they have been deleted from
Win School. When you update the Health database with Win School data, a
red asterisk appears beside those records that have been flagged for archive.

studert record is | I | Humber | Student Hame

flagyed for archive—bl = oza0s @] skaloft, Anna-Marie Lee

070329 8| Allen, Rob Darren

TO CREATE AN ARCHIVE FILE:

-

From the View menu, choose Archive Contents.
Click New Atrchive.

In the Filename field, type the name of the archive.

A O N

In the Notes field, type any details you want.

Filename |Spring 2000
Hotes  [Jan 4 through Mar 31

[Eovad
ArEhne

Delete

Archive << Back

Add |

5 Click Add to create the archive database.
6 In the dialog reporting your archive was successfully created, click OK.

In the Archive File Management dialog, the archive file information

appears.
Archive File Created Hotes
| 3|Spring 2000 | 12001/99 8:48:40{DBAdmin_ [Jan 4 through Mar 31

Delete
Archive

Hew
Archive

Spting 2000 |

7 Click OK to close the Archive File Management dialog,
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Archiving Records
To archive records, you must be the only user connected to the database and
records must be flagged for archive. Records are flagged when they have
been removed from the Win School database.
TO ARCHIVE RECORDS:
1 From the File menu, choose Archive Student Information.

2 In the Archive File Management dialog, select the archive file to which you
want to save the records, then click Archive Records.

Archive File Created Hotes
12| SEIEEE | 10i04/39 14:41:17|[0BAdmin |Sept 7 to Dec 31

Archive Delete Hew
Records | Archive Archive
Fall15589

2 records are flagged for archive.

3 In the dialog that appears, click OK.
4 In the message that appears, click Yes.

5 Click OK to close the Archive File Management dialog;

Viewing Archive Files
Display archive records to view student records that have been removed
from the Win School database.

The Health Module Archive window shows you demographic, doctor and
dentist, contact, general medical, immunization record, condition record,
and examination record information. All of the information you entered in
Health appears in the archive file.

TO VIEW AN ARCHIVE FILE:

1 From the View menu, select Archive Contents.

44 | Setting Up Health
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2 Select the archive file, then click Load Archive to display the archive file. The
Health Module Archives window opens.

. R
Print Repoit Current Archive File - Spring 2000 Done
Student # Fame CGender rchive Date ==
2004E035 | Pan, Peter Wiliam hale 23-Jun-00
2004E036 | Hurtis, Kely Female 23-Jun-00

' Demographic WO"EI Doctor/Dentist Info | Contact Info | General Medical Infol Immunization Fecords | Health Condition Records | Examination Recards |

1720 Kurtis, Kelly

Fhone :

Gender : [Female |
Address : .

Birth D1ate: N |
City : A Ethnic Cateqory: H7A |
State / Zip: :

H L. g Englizh
B 7 TR el T |
Area ¢ County T Meemal Progar:
Social Security Mum : | | Grads:
Medicare Mumber: | | Hemeraom Number:

3 To print the archive, click Print Report, then select the appropriate radio
button, and click Print.

4  Click Done.

Deleting Archive Files
TO DELETE AN ARCHIVE FILE:

1 From the View menu, choose Archive Contents.

2 In the Archive File Management dialog, select the archive file you want to
delete, then click Delete Archive.

3 In the confirmation message that appears, click Yes.

4  Click OK.
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USING MEDICAL RECORDS

Using the Main Window

The Main window displays the list of students imported from Win School
into your Health database.

Make sure you have a schedule for regularly updating student information
from Win School. This will ensure you are working with the latest
information.

Navigating the Main Window

You can see the total number of student records at the bottom of the Main
window.

record: 14 4 ] 1 e e e#] of 316

click fo display the first recard J { total records
click fo display the prewious record - L click fo display the last record
displays the current record click fo display the necst recard

There are several different ways to move around the student list.

To Do

move up and down the list use the scroll bar

go to the last record click the right-most arrow

go to the first record click the left-most arrow

go to the next record click the Right arrow or press the Down
arrow

go to the previous record click the Left arrow or press the Up arrow

go to a record number type the record number in the current record

text box and press Enter

Viewing and Selecting Student Records

Using Medical Records
Using the Main Window

To view one record, double-click that student record in the Main window.

To display several student records one after another, select those records
first. You must select a student record in the Main window, before you can
use the Medical Info button or Student Medical Record from the Edit menu.

You can select one, several, or all student records in the Main window.

You might want to sort and select a group of student records, for example,
when you want to assign an immunization.



Use the following ways to select student records:

* In the Main window, click the checkboxes in the Select column to select
records.

* In the Select column, click the checkbox of the first record, then shift-click
the checkbox of the last record to select all records in between.

* Click the Select column heading to select or deselect all student records.

* Select one checkbox, then press Return to select or deselect subsequent
records (the first record is deselected.)

TO VIEW ONE STUDENT RECORD:

* In the Main window, double-click the record.

TO VIEW A SERIES OF STUDENT RECORDS:

1 In the Main window, click the checkboxes in the Select column to select
records.

2 Click Medical Info.

Medizal Inta
OR
From the Edit menu, choose Student Medical Recotrd.

3 The student’s medical record opens showing the Student Profile by default.
To display the student’s emergency information, immunizations,
examinations, conditions, or picture, click the appropriate button.

+ o | E

Emergency Student Profile  Immunizations | Examinations Conditions Picture

4 To view the next or previous record, click the left or right pointing button.

In the Student Profile view, the Medical Alert is displayed at the bottom. In
the Immunizations, Examinations, and Conditions view, a Medical Alert
button appears under the Next and Previous buttons for students who have
medical alert information. Click the Medical Alert button to display the
Medical Alert for that student.

click to wiew the prewiously selected student record ’m | |_|‘|

click 1o wiew the next selected siudent record - =
Medical lert

click 1o wiew this siudent's Medical Alert information :EF—I

5 When you’ve finished, click OK.
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Zooming into Fields

You can zoom into fields to display the field contents in a larger window.

TO ZOOM INTO A FIELD:

Click in the field and press Shift-F2. If the field is modifiable, type the text in
the dialog, then click OK.

Sorting Student Records

Sorting lets you arrange student records into groups. You can sort the Health
database on any column in the Main window.

For example, you might be conducting eye and vision screening programs
for all Grade 9 students. To group Grade 9 students, click the Curr Grade
column heading to sort that column. Scroll to display records with 09 in the
Curr Grade column.

Inactive student records are always sorted to the bottom of the list.

TO SORT COLUMNS:

Click a column heading in the Main window (except the Select column) to
sort that column in ascending order.

The column heading changes to navy blue to indicate that the Main window
is sorted on that column.

Click the column 27 UL L
hieading to sortin | Akaloff, Anna-Matie Lee
ascending arder: | Allen, Rob Darren

Click the sorted column heading again to sort that column in descending
order.

Viewing Inactive Student Records

Using Medical Records
Using the Main Window

A flag indicates student records that are no longer active in Win School.

A student record is inactive when that student is not currently enrolled;
either the student has withdrawn, or the student entry date has not yet
arrived.

It is important to know which student records are inactive, such as when
administering immunizations.

Humber | Student Hame
student recard 023103 B Abaloff, Anna-Marie Lee

s inachie ——pPP=070529 @) Allen, Rob Darren

When you sort the database, inactive student records are always sorted to the
bottom by default.



Viewing Records Marked for Archive
When student records are removed from Win School, a red asterisk appears
in the column to the left of the student number after you run WS Update.
For example, a student might have transferred to a different school district.

studert record is | I | Humber | Student Hame

flayec for archive—b' = oza0g 3] Akalof, Anna-Marie Lee

0705239 & 2llen, Rob Darren

When you archive data, student records with a red asterisk are removed from
the Health database and saved in an archive file.

Viewing Emergency Information

Use the Emergency Information window to quickly access critical health
information.

The Emergency Information window contains display-only information on
the following four tabs:

Demographics personal information, including the student’s address and
phone number

Doctor Info doctor and dentist’s name, address, and phone number
Medical Info health conditions, medical alerts, and comments
Contact Info name, relationship with student, address, and phone number

of up to 4 contacts and up to 2 emergency contacts

TO DISPLAY EMERGENCY INFORMATION:

1 In the Main window, click the Emergency icon.

click to display | Student
EMErgency ] Abaloff, Anna-harie Lee

irformation  —wea] Allen, Rob Darren
OR

From the View menu, choose Emergency Information.
OR

In the Student Medical Record, click Emergency.

)

Emergency

2 Click a tab to display the information for that tab.

You cannot change information in the Emergency Information window.
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3 To display medical alerts, click the Medical Info tab.

4 When you have finished viewing the information, click Close.

Working with Student Medical Records

Using Medical Records

A student’s medical record gives you an overview of the student’s medical
health information.

In a student’s medical record, you can:

view emergency information

view and override provisional enrollment status
view and update doctor and dentist information

If you have elected to maintain doctor information in Win School, you must
edit doctor information in Win School.

view and update health profile

view Win School legal and medical alert

view and update Health module medical alert

view and update immunizations, including exemptions
view and update examinations

view and update conditions

view student picture

TO DISPLAY MEDICAL RECORDS:

If you want to use the Next and Previous buttons to display a series of
medical records, select the students in the Main window.

Click Medical Info.

Medical Info

OR
From the Edit menu, choose Student Medical Record.
OR

Double-click a student name.

Working with Student Medical Records



3 The student’s medical record opens in the Student Profile view by default,
showing:

* doctor or dentist information on the left
* student health profile on the right

* medical and legal alerts on the bottom

o | 5 B

Emergency Student Profile  Immunizations | Examinations Conditions Picture

The following table shows what you can do in the student medical record.

To Click

View Emergency Emergency

information

Work with dentist the doctor information popup menu
information and select dentist information.

Work with immunizations Immunizations

Work with examinations Examinations

Work with conditions Conditions

View student picture Picture

If you have selected students in the Main window, use the Next and Previous
buttons to display selected students’ records.

4 When you’ve finished, click OK.

Maintaining Student Profiles

You can maintain health related information in the Student Profile,
including:

*  Doctor Information (if you chose to maintain it in Health and not
Win School)

*  Dentist Information

¢ Student Height, Weight, Immunization Status, and Provisional Enrollment
status

*  Health module Medical Alert and comments

Using Medical Records
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Some information in the Student Profile is maintained in Win School and
can be viewed but not changed in Health, including:

Doctor Information (if you chose to maintain it in Win School and not
Health)

Student Disability

Call Ambulance

Call Doctor

Can Treat

Legal Alert

Win School Medical Alert and comments

For more information on which fields are maintained in which application,
see “Differences Between Health and Win School” on page 33.

Maintaining Doctor and Dentist Information

Using Medical Records

You can maintain doctor information either in Win School or locally in
Health. You select this when you set up Health in “Setting Up Doctor
Information Source” on page 12.

If you maintain doctor information in Win School, that information is
updated in Health when you choose Update from Win School Database
from the File menu or click WS Update. For information on maintaining
student information in Win School, see the Win School Details Guide.

If you maintain doctor information in Health, you enter and maintain both
doctor and dentist information in Student Profile.

TO MAINTAIN DOCTOR AND DENTIST INFORMATION:

If you want to work with a series of records, select the students in the Main
window.

Click Medical Info.

tedical Info
OR
From the Edit menu, choose Student Medical Record.
In the Student Profile, enter that student’s doctor information.

To maintain dentist information, click the popup menu in the top left and
select Dentist Information. Enter that student’s dentist information.

Maintaining Student Profiles



5 Use the Next and Previous arrows beside the student name to move to
different records.

6 When you have finished maintaining doctor and dentist information, click
OK.

Maintaining Student Health Information

You can maintain student height, weight, immunization status, and
provisional enrollment status in the Other Information area in the Student
Profile.

Provisional Enrollment status is automatically calculated based on the
immunization requirements you have set up.

Overriding Provisional Enroliment Status
In the Student Profile, you can override a student’s Provisional Enrollment
status. For example, if a student received an immunization dose just before
the required date, or you are sure a student has received all required
immunizations but does not have the documentation and the dates, you
might want to override that student’s Provisional Enrollment status.

Manually overriding a student’s Provisional Enrollment status has two
effects:

* The student’s Provisional Enrollment status remains on Override until you
manually change it.

* The student’s Provisional Enrollment status is not automatically updated,
that is, Health no longer checks that student’s Provisional Enrollment status
based on immunization requirements.

TO MAINTAIN STUDENT HEALTH INFORMATION:

1 If you want to work with a series of records, select the students in the Main
window.

2 Click Medical Info.

b edical Info

OR
From the Edit menu, choose Student Medical Record.

3 In the Student Profile, enter that student’s health information in the Other
Information area, including:

*  Medicare number

* height and weight

Using Medical Records | §3
Maintaining Student Profiles



* if the student is exempted from immunizations, select a reason from the
Immunization Status popup menu

° to override a student’s Provisional Enrollment status, select the Override
checkbox, then you can change the Provisionally Enrolled checkbox and the
Provisionally Enrolled Date.

The other fields are maintained in Win School.

4  Use the Next and Previous arrows beside the student name to move to
different records. When you’ve finished, click OK.

Entering Health Module Medical Alerts

The Medical Alert area shows two medical alert conditions: one you enter
and update in Health; the other is imported from Win School.

Win School medical alerts and comments are maintained in Win School.

Students who have medical alerts have a medical alert flag in the Main
window. You can sort by the Medical Alert column to quickly see which
students have medical alerts.

! Humherl
Medical alert flag——» ! 194 Blstu
!9z BlsTu

TO ENTER MEDICAL ALERTS:

1 If you want to work with a series of records, select the students in the Main
window.

2 Click Medical Info.

Medical Infa
OR
From the Edit menu, choose Student Medical Record.

3 Type the information in the Health Module Medical Alert fields.

Medlcal.&ien _ I A A 19880y 0 % T 800 B g gy

Health I'H'Il:ldule Me‘dlcal .ﬂ.lert Cundltmn .:‘_:'.H.E’Eﬂ-th Module Medical Alert Comments -

Allergies: bee stings, seafood, peanuts, and cats - [Reaction: swels up, hives, and findzs it difficult to bresth
.| Treatment: Adrenalin |nject||:|n or Caladr':.fl cream

Wm Sch.ﬂuf Medlcal AIEI‘I ['fundlﬂun ZWm Schuul Medmal f-’tleft Cummerrts

I.ﬂ«s’[hma Severe -, . 0 T ]req"ulres inhaler and hregtlji‘ng maihine - B 900
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4 Use the Next and Previous arrows beside the student name to move to
different records. When you’ve finished, click OK.

Viewing Medical Alerts

The Medical Information window lists medical alerts for students who have
crucial health information entered in Health or Win School.

TO DISPLAY MEDICAL ALERTS IN THE STUDENT PROFILE VIEW:

*  Double-click a student record.
The Student Profile opens.

The Win School and Health medical alerts, comments, and conditions
appear at the bottom.

The Win School legal alert also appears.

TO DISPLAY MEDICAL ALERTS IN THE IMMUNIZATIONS, EXAMINATIONS,
OR CONDITIONS VIEW:

1 If you want to work with a series of records, select the students in the Main
window.

2 Click Medical Info.

Medical Info

OR
From the Edit menu, choose Student Medical Record.
OR
Double-click a student recotd.
3 Click Immunizations, Examinations, or Conditions.

For those students who have crucial medical information, a Medical Alert
button appears.

click to wiew the prewiously selected student record -’Vm | |_|‘|
click 1o wiew the next selected student record =V
hedical Alert |
click to wiew tis studert's Medical Alert information
4 Click Medical Alert to display the Win School and Health medical alerts,

comments, and conditions.

5 Click Close.
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Viewing Student Pictures
You might want to open the student’s picture to make sure the student
record you are accessing belongs to the student in your office.
TO DISPLAY A STUDENT PICTURE:

1 In the Main window, select a student and click Picture.

OR

From the View menu, choose Student Picture.
OR
In the Student Medical Record, click Picture.

2 When you have finished viewing the picture, click Close.
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ADMINISTERING IMMUNIZATIONS

Assigning an Immunization to Many Students

You can pre-assign all required immunizations to each group of students
with blank dates and an Action of N/A. Then you can easily see which
students need which immunizations. See “Assigning Required
Immunizations to Students (Batch Assign)” on page 27.

Batch assigning an immunization to many students is useful when many
students receive the same dose on the same day.

When you administer an immunization, specify the date and select
Administered for the Action. Health overwrites the immunization and dose
of the same name with the new date and action.

TO BATCH ASSIGN A DOSE TO SEVERAL STUDENTS:

1 If you want, sort the students by clicking the column heading in the Main
window.

2 Select the students to be assigned an immunization dose.

3 Click Batch Assign. Then click Immunizations.

Batch Azsign

OR

From the Edit menu, select Batch Assigh Immunization.
From the popup menus, select the Immunization and Dose.
From the Action popup menu, choose Administered.

In the Date field, type the immunization date.

N o0 a b

If you want, select the “Don’t add immunization if it’s already assigned with
this date” checkbox.

If you select this checkbox, students with the identical Immunization, Dose,
Action, and Date will be skipped.
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Whether you select this checkbox or not, if existing students have the
identical Immunization and Dose with an Action of N/A and an empty
Date, Health replaces those records with the new immunization data.

% Immunization Batch Azsignments - Health Module E

Select the Immunization you want to azsign to selected students

Immunization : IF'DIiD ;I
Dose IPolin Doze 1 ;I
Action : I.-’-\dmini&tered ;I
Date : IDE-Sep-DD

Comments :

Options
’7 [+ Don't add immunization if it's already assigned with this date

Azgign | Dione |

8 Click Assign to begin assigning the immunization to the selected students.

9 A dialog shows how many students will be assigned that immunization dose.
Click Yes to accept the batch assign.

Assigning an Immunization to One Student

If you need to assignh immunizations to one student, use the student’s
medical record. For example, if you have a form showing a student’s
immunization history and you need to enter this student’s immunizations
into his record.

See “Viewing or Updating Student Immunizations” in the next section.
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Viewing or Updating Student Immunizations

In student medical records, you can view and update immunizations.

TO VIEW OR UPDATE IMMUNIZATIONS IN MEDICAL RECORDS:

1 If you want to work with a series of records, select the students in the Main
window.

2 Click Medical Info.

M edical Info

OR

From the Edit menu, choose Student Medical Record.
OR

Double-click a student record.

3 The student’s medical record opens showing the Student Profile by default.
Click Immunizations.

If that student has a medical alert, a Medical Alert button appears under the
Next and Previous arrows.

To change the Date, Action, or Reaction of an immunization, make changes
in the appropriate column.

OR

Select an immunization, click Edit, make changes, and click OK.

OR

Double-click an immunization, make changes, and click OK.

To add an immunization, click Add, specify the details, and click Assign.

To delete an immunization, select that immunization and click Delete. If
>
you’ve deleted an immunization by mistake, click Restore.

4 If you have selected multiple students, click the Next arrow to view the next
student’s immunizations.

5 When you’ve finished working with immunizations, click OK.

Selecting Report Options

In the Immunization History and Immunization Summary report, you can
select options to report only students in specific categories.
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Students in Category

Dose is administered,
meeting all its requirements

Dose is exempted, meeting
all its requirements

Dose is administered, even
though it is not required

Dose is exempted, even
though it is not required

Dose is neither adminis-
tered nor exempted, and is
violating its requirements,
and is still within the provi-
sional enrollment period

Dose is neither adminis-
tered nor exempted, and is
violating its requirements,
and is past the provisional
enrollment period

Dose is administered and is
violating its requirements,
and is still within the provi-
sional enrollment period

Dose is administered and is
violating its requirements,
and is past the provisional
enrollment period

Dose is exempted and is
violating its requirements,
and is still within the provi-
sional enrollment period

Dose is exempted and is
violating its requirements,
and is past the provisional
enrollment period

The following table shows which students will appear in which report
selection. One category does not supersede another, that is, all categories are
of equal priority.

Category
Provisionally
Enrolled
Fully Adminis- and not Non-
Compliant tered Exempt Delinquent Delinquent | compliant | Incomplete
4 4
4 4 v
(except military
exemption)
4 4
4 4
4 4 v
4 4 v
4 4 4 v
v v 4 4
4 4 v v
4 4 4 v
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Viewing Immunization History

The Immunization History report lists students’ immunization history,
including students who are exempted from immunizations.

You can use this report to list students who are provisionally enrolled on the
day you run the report, or specify a date to forecast which students will be
provisionally enrolled at a future date.

Use this report to view or print the immunization history of individual
students. You can run this report for selected students or a selected
population to get a snapshot of their immunizations.

To produce a report, you must select at least one immunization in the
Immunizations tab, and at least one option in “Include the following
students” in the Students tab. All other options are optional. The report is
run based on all the options you select.

The following examples show using the forecast date to produce reports
based on selections in the Immunizations and Students tabs.

Selections in Selections in Students Report shows

Immunizations tab

tab

One immunization ® Run report using Both provisionally enrolled students
forecast date and not provisionally enrolled

students for that immunization on
the forecast date

One immunization ® Provisionally enrolled Only provisionally enrolled students
students only for that immunization on the
® Run report using forecast date

forecast date

Several ® Run report using Both provisionally enrolled students

immunizations forecast date and not provisionally enrolled
students for selected immunizations
on the forecast date

All immunizations ® Provisionallyenrolled Only provisionally enrolled students
students only for all immunization on the forecast
® Run report using date

forecast date

Consider carefully what you want to report on. Running this report for a
large number of students might take a long time and generate a huge report,
for example, running this report for the entire school might an hour or more
and produce a thousand-page report.

TO VIEW OR PRINT THE IMMUNIZATION HISTORY REPORT:

1 If you want to run a report on selected students, select them in the Main
window.
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You must select the student(s) to be included in the report. You can specify
one of the following options:

e selected students in the Main window
* selected student population in the Students tab
* all populations in the Students tab

2 Click Reports and choose Immunization History.

d

Reportz
OR
From the Reports menu, choose Immunization History.

3 The Immunization History Report dialog displays the Immunizations tab by
default. Select one or more immunizations.

B Immunization History Report - Health Module [_[E]X]

2 o]
Frint Report | “/rite to File

Imrunizations | Studentsl Displa_l,ll

— Include details for the following imrunization

DTP/DTaP -
Hep B

Hib

Meazles Fie
MMR ;I

— Student history criteria

Include only students who have the following actions for at least
one selected immunization:

™ Administered ™ Exempt

™ Include immurizations as of: ID‘IJan-SD

™ Include students who need the selected vaccine, but have newver received it
[Does not include students whao have received the vaccing, even if the
timing was inappropriate. |

Cloge |

Select To show

Administered Students who have received any of the selected
immunization(s).

Exempt Students who are exempt for any reason from any selected
immunization(s).

Neither Administered Students who are not exempt for any reason, including

nor Exempt students with required immunizations even if the

immunization has not been assigned to them.
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Select

To show

Both Administered and
Exempt

Students who either have any of the selected immunization(s)
assigned to them, or are exempt from any of the selected
immunization(s).

Include immunizations
as of

Students who have received the selected immunizations on or
after the specified date.

Include students who
need the selected
vaccine, but have never
received it

Students who require the selected immunization, but do not
have it assigned to them, or assigned with an Action of N/A.
For this option, you can select only 1 immunization.

This option is different from selecting provisionally enrolled
students. If you want to report on provisionally enrolled
students, see step 4 below.

4 Click the Students tab and select the students to be included in the report.

To list only the students who are provisionally enrolled, select “Provisionally

enrolled students only”. This lists on/y provisionally enrolled students.

To include students who are forecasted to be provisionally enrolled, type a
future date in “Run report using forecast date”. This lists bozh provisionally
enrolled and non-provisionally enrolled students on the forecast date.

To list only students who will be provisionally enrolled on the forecasted
date, select “Provisionally enrolled students only” and type a date in “Run
report using forecast date”.

Immunization History Report - Health Module

07-Jun-01

5 Click the Display tab and select display options.
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Select “Include comments (landscape format)” to view or print comments
on your report. For increased readability in this format, you can resize the
report onscreen.

EJ Immunization History Report - Health Module !EE
L1 %5
‘fiews Report | Print Fepart | Srite to File

Immunizationsl Students  Display |

Sort students by: [Stuident Name =1
— Options
W Social Security Mumber ¥ Birthdate
¥ tedicars Mumber ¥ Gendsr
V¥ Current Homeroom [T Parent/Guardian Mame, Address,
o and Phone Number
W Curent Age ™ Mailing Address
— Print Range
(¢ Al Pages

' Pages Fram: I— Ta: I—

™ Frint constraints on first page

™ Piint each student on zeparate page

¥ Include comments (landscape fomat)

Cloze |

6 To display the report, click View Report at the top.
To print the report, click Print Report.

To save the report as a file, click Write to File. Then specify the file format,
name, and location.

7 When you have finished running the report, click Close.

In the Immunization History report, the Age column shows one of the
following:

 if the student has received the dose and has met all immunization
requirements, the Age column shows the student’s age (immunization date -
birthdate)

* if the student did not receive the dose, the column shows N/A
* if the student’s birthdate is blank, the column shows N/A

* if the student’s birthdate is later than the immunization date, the column
shows INV
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Viewing Immunization Summary

Use the Immunization Summary Report to print or view:

totals by dose for any single population

totals by dose for all combined populations

totals by immunization title for any single population

totals by immunization title for all combined populations.

At the immunization title level, users can view or print the following totals:
total number fully compliant (includes exempt and up-to-date)

total number of medical exemptions

total number of religious exemptions

total number of parental exemptions

total number of illness exemptions

total number of military exemptions

total number provisionally enrolled

total number delinquent

total number noncompliant (includes provisionally enrolled and delinquent)

total number incomplete (includes provisionally enrolled, delinquent, and
exempted from required immunizations)

You can calculate all totals, at both the dose and immunization title levels, for
a selected population or for all populations.

Understanding the Report Totals

At the immunization title level, the totals for fully compliant include all
students who are up-to-date on all administrations. That is, students who
require and have received an immunization, require and are exempt from an
immunization, or don’t require an immunization.

At the immunization title level, Health accumulates totals for exemptions by
counting a single student once if that student received one or more
exemptions for an immunization title.

Fully compliant students who are assigned or administered a dose that is not
part of their requirements are still considered fully compliant. The following
cases are considered fully compliant:

a dose is not required, but is assigned and administered
a dose is not required, but is assigned and medically exempted

a dose is not required, and is not assigned

Administering Immunizations | @5
Viewing or Updating Student Immunizations



As this example shows, totals for the immunization title level appear on the
report before the totals for individual doses.

Immunization Summary Report
Population: Year: f
Irmrmuni ation Title: Polio

Dose: All Doses

Fully compli ant: 3
Medi cal E xemption:
Religious Exemption:
Parental Exemption:
lliness E xemption:
Military E xemption:
Provisionally Enrolled
and Hot Ddinquent

Delinquent
Honcompliant
Incomplete:

N TR

Gt Pl B =

Dosze: Polio Dose1

Administered:

Medical Exemiption:

R eligious Exemption
Parertal Exemption
lline=s Exemption:

Military Exem ption:
Provdsionally E nrolled and
Mot Delinguent: 0

o OO = O W

Delinguent: 1
Moncompliant:
Incom plete: 2

-

The following table shows how Health calculates totals for this report, both
at the immunization title level, and at the individual dose level.

Totals on the Immunization Title for the selected population:

Fully Compliant | The number of students in the selected population who have satisfied
all requirements for all doses for this immunization. This includes the
following students:
¢ students who need certain doses in a specific time period and have

received all doses in that time period, ot have been exempted from
them
¢ students who do not need the dose, regardless of whether they
received it or not
All students are either fully compliant or noncompliant for an
immunization, that is, if you add the total of fully compliant and
noncompliant, you will get the total number of students in that

population.
Medical The number of students in the selected population who have medical
Exemption exemption from receiving at least one of the current immunization

doses. If a student has a medical exemption for more than one of this
immunization’s doses, he is counted only once in this total.
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Religious
Exemption

Parental
Exemption

Illness
Exemption

Military
Exemption

Provisionally
Enrolled and
Not Delinquent

Delinquent

Noncompliant

Incomplete

The number of students in the selected population who have religious
exemption from receiving at least one of the current immunization
doses. If a student has a religious exemption for more than one of
this immunization’s doses, he is counted only once in this total.

The number of students in the selected population who have parental
exemption from receiving at least one of the current immunization
doses. If a student has a parental exemption for more than one of this
immunization’s doses, he is counted only once in this total.

The number of students in the selected population who have illness
exemption from receiving at least one of the current immunization
doses. If a student has a illness exemption for more than one of this
immunization’s doses, he is counted only once in this total.

The number of students in the selected population who have military
exemption from receiving at least one of the current immunization
doses. If a student has a military exemption for more than one of this
immunization’s doses, he is counted only once in this total.

The number of students in the selected population who have violated
at least one of the immunization’s dose requirements, but are still
within their grace period for all of the dose violations.

The number of students in the selected population who have violated
at least one of the immunization’s dose requirements, and are past
their grace period for at least one of these dose violations.

The number of students in the selected population who have violated
at least one of the immunization’s dose requirements, regardless of
the grace period. This is the total of students who are provisionally
enrolled, plus those who are delinquent.

The number of students in the selected population who have violated
at least one of the immunization’s dose requirements, regardless of
the grace period, plus students who have medical, religious, parental,
or illness exemption from at least one dose with a requirement.

This does not include military exemption.

This is not a straight total of noncompliant plus all exemptions except
military exemption. This is because a student may have a medical
exemption for dose 1 and a religious exemption for dose 2.

For a specific dose in a specific immunization for the selected population:

Administered

Medical
Exemption

Religious
Exemption

Parental
Exemption

The number of students in the selected population who have the
selected immunization dose administered at least once; regardless of
whether it satisfies the immunization requirements or not. Students
who receive the same dose more than once are counted only once.

The number of students in the selected population who have medical
exemption from getting this immunization dose. Students who are
exempted from the same dose more than once are counted only once.

The number of students in the selected population who have religious
exemption from getting this immunization dose. Students who are
exempted from the same dose more than once are counted only once.

The number of students in the selected population who have parental
exemption from getting this immunization dose. Students who are
exempted from the same dose more than once are counted only once.
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Illness The number of students in the selected population who have illness
Exemption exemption from getting this immunization dose. Students who are
exempted from the same dose more than once are counted only once.

Military The number of students in the selected population who have military
Exemption exemption from getting this immunization dose. Students who are
exempted from the same dose more than once are counted only once.

Provisionally The number of students in the selected population who have not
Enrolled and satisfied the immunization dose requirements, but are still within their
Not Delinquent grace period.

Delinquent The number of students in the selected population who have not
satisfied the immunization dose requirements, and are past their grace
period.

Noncompliant The number of students in the selected population who have not

satisfied the immunization dose requirements, regardless of the grace
period. This is the total of students who are provisionally enrolled,
plus those who are delinquent.

Incomplete The number of students in the selected population who have not
satisfied the immunization dose requirements, regardless of the grace
period, plus students who have medical, religious, parental, or illness
exemptions.

This is the total of noncompliant, medical exemption, religious
exemption, parental exemption, and illness exemptions.
This does not include military exemption.

Health calculates totals for all populations using the same criteria above,
both at the immunization title level and the individual dose level. Health adds
the totals of all defined populations to produce the total for all populations.

TO VIEW OR PRINT THE IMMUNIZATION SUMMARY REPORT:

1 Click Reports and choose Immunization Summary.

g

Feparts

OR
From the Reports menu, choose Immunization Summary.

2 The Immunization Summary Report dialog displays the Immunizations tab
by default. Select the immunization(s) you want.

3 C(lick the Students tab and select the student population for the report.
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To show a summary of all population totals, select “All Populations” in the
Students tab. This shows all doses and all populations.

E Immunization Summary Beport - Health Module

}@

Yiew Report | Print Report | Wite to File

= E3

Immunizations  Students IDispIayI

— Population

¢~ Al Populations

@ Select Population Tear b

=

— Include the following students

¥ Tatal number with adririztened
and fully compliant immunizations

¥ Tatal number with
medical exemptions

[V Tatal nurmber with
religious exemptions

Total number waith rilitary
exemptions

<1

Total numnber with
parental exemptions

<]

Total number with
ilnezz exemphions

<l

Tatal urmber provisionally
enrolled and naot delinguent

Tatal rumber
delinguent

Tatal nurmber with
incomplete immunizations

Tatal humber noncompliant

Include inactive students

Claze |

Select

Total number with

To show

administered and fully
compliant immunizations

Exemptions

Provisionally enrolled &

Not delinquent
Delinquent

period.
Noncompliant

deliquents.
Incomplete
immunizations

Students who have received all required immunizations.

Students who are exempt for the specified reason.

Students who have not received a dose by the required date
and are still within the provisional enrollment period.

Students who have passed the provisional enrollment

Students who are provisionally enrolled, including

Students who are delinquent, noncompliant and exempted
from required immunizations.

Click the Display tab and select display options.

To produce a report at the immunization level only and exclude the dose
level, deselect “Include totals by dose”.
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Example One

Example Two

5 'To display the report, click View Report at the top.

To print the report, click Print Report.

To save the report as a file, click Write to File. Then specify the file format,
name, and location.

When you have finished running the report, click Close.

If a student has passed the provisional enrollment period (delinquent) for
dose 2 and is still within the provisional enrollment period for dose 3, that
student is reported as “Delinquent” for dose 2 and “Provisionally Enrolled
& not Delinquent” for dose 3.

If a student received a dose earlier than the required date, that student is
listed first as both Administered and Provisionally Enrolled during the
provisional enrollment period; then as both Administered and Delinquent
after the provisional enrollment period.

This situation could happen if the provisional enrollment period is 30 days
and a dose is required within the last year. A student received the dose 2
years ago. As such, the dose was received but it does not meet immunization
requirements. Therefore during the 30-day provisional enrollment period,
the report shows 1 Administered and 1 Provisionally Enrolled. After the 30-
day provisional enrollment period, if you run the report again, it shows 1
Administered and 1 Delinquent.
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RECORDING EXAMINATIONS

Examining a Student

In a student’s medical record, you can log the examination you give to one
student. You can also check the student’s examinations, as well as
immunizations and conditions.

If you are recording an examination given to a class or group of students, see
“Assigning an Examination to Many Students” on page 72.

TO VIEW OR UPDATE EXAMINATIONS IN MEDICAL RECORDS:

1 If you want to work with a series of records, select the students in the Main
window.

2 Click Medical Info.

tedical Infa

OR

From the Edit menu, choose Student Medical Record.
OR

Double-click a student record.

3 The student’s medical record opens showing the Student Profile by default.
Click Examinations.

If that student has a medical alert, a Medical Alert button appears under the
Next and Previous arrows.

4 In the Sort Exams by line, click Exam to sort by examination title in
alphabetical order.

Click Date to sort by date in reverse chronological order, that is, latest
examination on top and oldest at the end.

5 To add an examination, click Add, select the examination from the popup
menu, and click Assign.

6 Select the status from the popup menu and in the bottom part of the dialog,
select the Category, Code, and type any comments.

To see the Comment field in a bigger dialog, click in the field and press
Shift-F2.
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7

8

If you have selected multiple students, click the Next arrow to view the next
student’s examinations.

When you’ve finished, click OK.

Assigning an Examination to Many Students

For required examinations, the easiest way is to assign all required
Examinations with blank dates to each group of students. Then when you
give the examination, change the date and add comments to the students that
need comments.

Assigning Required Examinations to Students (Batch Assign)

0 N o a »

Recording Examinations

You can assign an examination to a group of students. For example, if a class
requires periodic head lice examinations, pre-assign the examinations with
scheduled future dates. When an examination is given, record the results with
any comments.

TO BATCH ASSIGN AN EXAMINATION:

If you want, sort the students by clicking the column heading in the Main
window.

Select the students who are getting the examination.

Click Batch Assign. Then click Examinations.

Batch Azzign

OR

From the Edit menu, select Batch Assign Examination.

From the Examination popup menu, select the Examination.

From the popup menus, select an Exam Status and Exam Code(s).
Type the Exam Date and any Comments.

Click Assign to begin assigning the examination to the selected students.

A dialog shows how many students will be assigned that examination. Click
Yes to accept the batch assign.
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Showing a List of Examinations

Use the List of Examinations report to show student’s examinations.

TO VIEW OR PRINT THE LIST OF EXAMINATIONS REPORT:

1 Click Reports and choose List of Examinations.

=
5
OR
From the Reports menu, choose List of Examinations.
2 Select the examination(s) you want to report on, and other report options.
3 To display the report, click View Report at the top.
To print the report, click Print Report.

To save the report as a file, click Write to File, and specify the file format,
name, and location.

4 When you have finished running the report, click Close.

Showing a Summary of Examinations

Use the Examination Summary report to summarize examinations for all
students or students in a range of grades or ages.

Please note the following in the Examination Summary report:

* Since students usually do not have the same examination more than once a
day, in the rare instance when this happens, that student will be counted
more than once in this report’s totals.

* Examinations with a Code or Category of N/A ate not included in this
report.

TO VIEW OR PRINT THE EXAMINATION SUMMARY REPORT:

1 Click Reports and choose Examination Summary.

d

Reports

OR

From the Reports menu, choose Examination Summary.
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2 In the Examinations tab, select the examination(s) you want to report on,
and other report options.

3 Click the Students tab and select the students to be included in the report,
and other student options.

4 Click the Display tab and select display options.
5 To display the report, click View Report at the top.
To print the report, click Print Report.

To save the report as a file, click Write to File. Then specify the file format,
name, and location.

6 When you have finished running the report, click Close.
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RECORDING HEALTH CONDITIONS

Viewing or Assigning Student Conditions

In student medical records, you can view and update student health
conditions.

TO VIEW OR UPDATE STUDENT HEALTH CONDITIONS IN MEDICAL
RECORDS:

1 If you want to work with a series of records, select the students in the Main
window.

2 Click Medical Info.

tedical Infa

OR

From the Edit menu, choose Student Medical Record.
OR

Double-click a student record.

3 The student’s medical record opens showing the Student Profile by default.
Click Conditions.

If that student has a medical alert, a Medical Alert button appears under the
Next and Previous arrows.

To add a condition, click Add, then select the condition Title and specify
other details.

To change the condition Title, Level, Date, or Comment, make changes in
the appropriate column.

To delete a condition, select that condition and click Delete. If you delete a
condition by mistake, click Restore.

4 If you have selected multiple students, click the Next arrow to view the next
student’s condition.

5 When you’ve finished working with conditions, click OK.
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Assigning a Condition to Many Students
(Batch Assign)
You can batch assign a health condition to many students at once.

TO BATCH ASSIGN A CONDITION:

1 If you want, sort the students by clicking the column heading in the Main
window.

2 Select the students who will be assigned the condition.
3 Click Batch Assign. Then click Health Conditions.
OR
From the Edit menu, select Batch Assign Condition.

4 TFrom the popup menus, select the Condition, Level, and up to four pre-
defined comments. You can also type comments in the Nurse’s Comments
text box.

5 Check that the date is correct.
6 Click Assign to begin assigning the condition to the selected students.

7 A dialog shows how many students will be assigned that condition. Click Yes
to accept the batch assign.

Listing Health Conditions

Use this report to list students’ health conditions.

TO VIEW OR PRINT THE LIST OF HEALTH CONDITIONS REPORT:
1 Click Reports and choose List of Health Conditions.

OR
From the Reports menu, choose List of Health Conditions.

2 Select the conditions and levels you want to report on, and other report
options.

3 To display the report, click View Report at the top.
To print the report, click Print Report.

To save the report as a file, click Write to File. Then specify the file format,
name, and location.

4 When you have finished running the report, click Close.
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GLOSSARY

Use the following list of terms to assist your understanding of Health.

ASCII
American Standard Code for Information Interchange. A character set
counting 94 printable characters and 34 other characters such as space, bell,
shift-in, tab, and so on. Used as a format for transferring data from one
computer to another.

At Least

In Health, an option that means equal to or greater than a specified number.

Batch Assigning

Entering a condition, immunization, or examination for a group of selected
students, such as for a grade, age, or homeroom.

Condition
Any type of physical or emotional incidents and circumstances that are
neither examinations nor immunizations.

Contact
A person who takes care of a student or who can be called in an emergency.
Contacts usually include the student’s parents.

Delinquent
A report selection to show students who do not meet the requirements and
for whom the grace period has expired.
For more information, see “Selecting Report Options” on page 59.

Dose
A specific dose of an immunization, such as a booster shot or one in a series
of immunization doses.

Examination

Any type of review of a student’s physical or emotional condition, including
screenings.
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Exemption

Fully Compliant

Immunization

Import

A flag indicating that a student does not have to receive an immunization or
an immunization dose. Exemption reasons include medical, military, illness,
parental, and religious.

A report selection to show students who have satisfied all the requirements
for all doses for an immunization. For example, if a dose is required for the
current population then the student must have had that dose administered
correctly, or be exempt for it. The student does not need the dose if it is not
required, and thus is fully compliant whether the student has received the
dose or not.

For more information, see “Selecting Report Options” on page 59.

Any type of medication provided to students to prevent infection.

A feature that lets you add data records from other software into the Health
database.

Inactive Student Record

Incomplete

IP Address

Non-compliant

Glossary

A student who is not currently enrolled; either the student has withdrawn or
the student entry date has not yet arrived.

A report selection to show students who are non-compliant, delinquent,
and/or exempted from required immunizations. This does not include
military exemption.

For more information, see “Selecting Report Options” on page 59.

A number that uniquely identifies a computer on a network. Health needs
the Win School Server’s IP address to find the student and attendance
information it uses.

A report selection to show students who are provisionally enrolled, including
delinquents.

For more information, see “Selecting Report Options” on page 59.



Population

A group of students. Populations can be based on a range of ages or grades.

Immunization requirements are set up for populations and some reports are
based on populations.

Students must be in a population to have immunization requirements and to
show up in reports.

Provisionally Enrolled

Students who do not meet the immunization requirements.

Students are reported as provisionally enrolled on the day an immunization
dose is overdue or on the first day of the school year, whichever is later.

Students remain provisionally enrolled until they satisfy all immunization
requirements.

Provisional Enroliment Period

Under

The provisional enrollment period (in days) in which a student is reported as
provisionally enrolled.

When the provisional enrollment period is passed, the Immunization
Summary report shows the students as Delinquent.

In Health, an option that means less than the specified number.

Up to and Including

User Account

WS Update

In Health, an option that means less than or equal to the specified number.

A user name and password that lets you access Health and secures the
database against unauthorized access.

There is a default user account, with the user name and password
“DBAdmin,” that is provided to the database administrator to set up user
accounts. After you log on the first time, change the administrator password.

All user accounts are set up with either Read Only, Full Access, or DBA
access.

A process that populates or brings Health up-to-date with information
entered in Win School.
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APPENDIX A: UPDATING FIELDS FROM
WIN ScHooOL TO HEALTH

When you run WS Update, Health copies these fields from Win School.

Student Demographics
WS Update copies the following Student Demographic fields from

Win School to Health.
* First Name
*  Middle Name
*  Surname
*  Gender
¢ Social Security Number
* Ethnic Category
*  Home Languages
* Birthdate
*  Phone Number
*  Mailing Address 1
*  Mailing Address 2
*  Mailing Address City
*  Mailing Address State

e Zip Code
*  Mailing Address Area
*  County

*  Mailing Address Country

If a student does not have a mailing address but has a physical address, WS
Update copies the physical address instead of the mailing address.

Contact Information
WS Update copies the following Contact Information fields from

Win School to Health.
* Title
e First Name
*  Middle Name
*  Surname
* Relation
*  Phone
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Address 1
Address 2

City

State

Zip Code
Employer
Position

Work Phone
Work Address 1
Work Address 2
Work City
Work State
Work Zip Code

Doctor Information
WS Update copies the following Doctor Information fields from

Win School to Health.
Medical Alert

Medical Comments

Doctor Information (if source is Win School)

If you chose to maintain doctor information in Win School, WS Update

copies the following additional Doctor Information fields from Win School

to Health.

Doctor Name
Doctor Address 1
Doctor Address 2
Doctor City

Doctor State

Doctor Zip Code
Doctor Office Phone
Doctor Home Phone
Legal Alert

Disability

Call Ambulance

Call Doctor

Can Treat
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APPENDIX B: IMPORTING FILES INTO
HEALTH

These are the format limits of fields you can import into Health 1.3.

Field Name
Student Number
Surname

Immunization Title
Description

Immunization Dose
Immunization Date

Immunization Action
Description

Immunization
Reaction Description

Immunization Note

Import_Examinations Template

Field Name

Student Number
Surname

Exam Record Number
Exam Date

Age

Grade

Exam Title

Exam Status

Exam Category

Exam Code
Description

Exam Comment

82 Appendix B: Importing Files into Health

Import_Immunizations Template

Data
Type
Character

Character

Character

Character
Date

Character

Character

Memo

Data Type
Character
Character
Long integer
Date

Integer
Character
Character
Character
Character

Character

Memo

Data Size

15
50
30

50
8
30

30

65,535

Data Size
15

50

6+

8

3 digits
3

29

29

29

29

65,535



Import_Conditions Template

Data
Field Name Type Data Size
Student Number Character 15
Surname Character 50
Health Condition Character 29
Description
Health Condition Character 29
Level
Date Recorded Date 8
1st Condition Character 255
Comment Text
2nd Condition Character 255
Comment Text
3rd Condition Character 255
Comment Text
4th Condition Character 255
Comment Text
Nurse’s Comment Character 65,535

Import_Demographics Template

Data
Field Name Type Data Size
Student Number Character 15
Surname Character 50
Medicare Number Character 39
Height Character 15
Weight Character 15
Medical Alert Character 255
Condition
Medical Alert Character 65,535
Comment
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APPENDIX C: EXPORTING FILES FROM
HEALTH

When you export Health data to dBase, Access, or Excel, Health creates the
appropriate files and fields, as listed in the following sections.

You can work with the exported Health data to run queries or generate
reports.

Exporting to dBase

Exporting to dBase creates the following six dbf files in the root folder of

drive C:

File name Description

HM_LDOIN.dbf Local doctor information

HM_DEIN.dbf Dentist information

HM_HDDA.dbf Student Health demogtaphic data
HM_IMDA.dbf Immunization data

HM_EXRE.dbf Examination records

HM_HCOD.dbf Health conditions (including level and comments)

Exporting to dBase also generates the following four (.dbt) memo files in the
root folder of drive C, related to database files containing memo field:

HM_EXRE.dbt HM_HCOD.dbt
HM_HDDA.dbt HM_IMDA.dbt

Doctor Information File HM_LDOIN.dbf
This file contains the Doctor details for each student from their Student

Profile.
Data
Field Name | Type Data Size Description
index Numeric 6 (decimal=0) Student ID (from Win School)
name Character 39 Doctor Name
offphone Character 23 Doctor Office Phone number
homephone Character 23 Doctor Home Phone number
addrl Character 35 Doctor Addressl
addr2 Character 35 Doctor Address2
city Character 35 Doctor City
state Character 29 Doctor State
Zip Character 13 Doctor Zip
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Dentist Information File HM_DEIN.dbf
This file contains the Dentist details for each student from their Student

Student Demographics File HM_HDDA.dbf

Field
Name

index
medicare
height
weight
studentaid
immcode
immdesc

legalalert

medalflag
medalcond
medalcomm
proventfla
provenrdat
lastupdate
arcflag
arcflagdat

user

Profile.

Data
Field Name | Type
index Numeric
name Character
offphone Character
homephone Character
addrl Character
addr2 Character
city Character
state Character
zip Character
lastupdate Date

Data Size Description

6 (decimal=0) Student ID (from Win School)
39 Dentist Name

23 Dentist Office Phone number
23 Dentist Home Phone number
35 Dentist Address1

35 Dentist Address2

35 Dentist City

29 Dentist State

13 Dentist Zip

8 Last update date

This file contains the student Health demographic data for each student
from their Student Profile.

Data Type
Numeric
Character
Character
Character
Character
Numeric
Text

Logical

Logical
Character
Memo
Logical
Date
Date
Logical
Date

Character

Data Size

6 (decimal=0)
39

15

15

50

11 (decimal=0)
30

1

254

o | oo

Description

Student ID (from Win School)

Medicare number

Height

Weight

(Not used)

Immunization Status Code (see table below)
Immunization Status Description (see table below)

Legal Alert Flag from Win School
(F=False, T=True)

Health module Medical Alert Flag (F=False, T=True)
Health module medical alert condition

Health module medical alert comment

Provisional Enrolment Flag (F=False, T=Ttrue)
Provisional Enrolment Date

Last update date

Archive Flag (F=False, T=True)

Archive Flag Date

User name
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Immunization Data File HM_IMDA.dbf

Field Name
index
itemcode
itemdesc
actioncode
actiondesc
date

time
dosage
nnote
lastupdate
user
reactionco

reactionde

Immunization Status

Code

1

o 9 o v A

Immunization Status Description
N/A

Religious Exemption

Parental Exemption

Medical Exemption

Military Exemption

Illness Exemption

This file contains the immunization record for each student from their
student medical record, including immunization, action, and reaction.

Data Type
Numetric
Numeric
Character
Numeric
Character
Date
Date
Numetric
Memo
Date
Character
Numetric

Character

Data Size Description
6 (decimal=0) Student ID (from Win School)
11 (decimal=0) Immunization Code
30 Immunization Title
11 (decimal=0) Action Code (see table below)
30 Action Description (see table below)
8 Date of the Immunization assignment
8 Time of the Immunization assignment
19 (decimal=5) (Not used)

Immunization Assignment Comment
8 Last update date
15 User name
11 (decimal=0) Reaction code
30 Reaction description

Immunization Action
Code

1

S NN NS B R R VR
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Immunization Action Description
N/A

Administered

Medical Exemption

Military Exemption

Parental Exemption

Religious Exemption

Illness Exemption



Examination Records File HM_EXRE.dbf
This file contains the examination records for each student from the
Examinations area in the student medical record, including examination title,
description, and exam code.

Data

Field Name Type Data Size Description

exindex Numeric 11 (decimal=0) Examination internal index

student Numetic 6 (decimal=0) Student ID (from Win School)

date Date 8 Date of the examination

age Numeric 6 (decimal=0) Student age at the time of examination
If student age is “N/A”, it is exported
as "500","0", or " " (blank)

grade Character 3 Student grade at the time of
examination

titlcode Numeric 11 (decimal=0) Examination title code

titldesc Character 29 Examination title

statcode Numeric 11 (decimal=0) Examination Status Code

statdesc Character 29 Examination Status name

catcode Numeric 11 (decimal=0) Examination Category code

catdesc Character 29 Examination Category name

ex2index Numeric 11 (decimal=0) Examination Code ID (code)

excdcode Character 29 Examination Code name

excddesc Memo Examination (Category) comment

user Character 15 User name

lastupdate Date 8 Date of examination

Health Conditions File HM_HCOD.dbf
This file contains the Health conditions for each student from the
Conditions area in the student medical record, including condition level and

comments.

Field Data

Name Type Data Size Description

index Numetic 6 (decimal=0) Student ID (from Win School)
condcode Character 4 Condition Code

conddesc Character 29 Condition Name

levelcode Character 4 Condition Level Code
leveldesc Character 29 Condition Level Name

date Date 8 Date of condition assignment
comlcode Character 4 Condition Comment code
comldesc Character 254 Condition Comment
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Field
Name

com2code
com2desc
com3code
com3desc
com4code
com4desc
comment
user

lastupdate

Exporting to Access

Data
Type
Character
Character
Character
Character
Character
Character
Memo
Character

Date

Data Size Description

4 Condition Comment code

254 Condition Comment

4 Condition Comment code

254 Condition Comment

4 Condition Comment code

254 Condition Comment
Additional Comment

15 User name

8 Last update date

Exporting to Access creates the HealthExport.mdb file in the C:\ root
directory. HealthExport.mdb contains the following six tables with no
relation between the tables.

LDOIN_LocalDoctorInformationExport
HDDA_HealthDemographicDataExport
EXRE_ExaminationRecordsExport

DEIN_DentistInformationExport
IMDA_ImmunizationDataExport

HCOD_HealthConditionsExport

Doctor Information Table, LDOIN_LocalDoctorinformationExport

This table contains the Doctor details for each student from their Student

Profile.
Field
Name
Index
Name
OffPhone
HomePhone
Addrl
Addr2
City

State

Zip
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Data Type

Number (integer)

Text (39 char)
Text (23 char)
Text (23 char)
Text (35 char)
Text (35 char)
Text (35 char)
Text (29 char)
Text (13 char)

Description

Student ID (from Win School)
Doctor Name

Doctor Office Phone number
Doctor Home Phone number
Doctor Addressl

Doctor Address2

Doctor City

Doctor State

Doctor Zip



Dentist Information Table DEIN_DentistinformationExport
This table contains the Dentist details for each student from their Student

Profile.

Field Name
Index

Name
OffPhone
HomePhone
Addrl
Addr2

City

State

Zip
LastUpdate

Data Type

Number (integer)

Text (39 char)
Text (23 char)
Text (23 char)
Text (35 char)
Text (35 char)
Text (35 char)
Text (29 char)
Text (13 char)
Date/Time

Description

Student ID (from Win School)
Dentist Name

Dentist Office Phone number
Dentist Home Phone number
Dentist Addressl

Dentist Address2

Dentist City

Dentist State

Dentist Zip

Last update date

Student Demographics Table HDDA_HealthDemographicDataExport
This table contains the student Health demographic data for each student
from their Student Profile.

Field
Index
Medicare
Height
Weigh
StudentAid
ImmCode

ImmDesc

LegalAlertFlag

MedAlFlag

MedAlCond
MedAlComm
ProvEntFlag

ProvEnrDate
LastUpdate
ArcFlag
ArcFlagDate
User

Data Type

Number (integer)

Text (39 char)
Text (15 char)
Text (15 char)
Text (50 char)

Number (long integer)

Text (30 char)

Yes/No

Yes/No

Text (255 char)
Memo

Yes/No

Date/Time
Date/Time
Yes/No
Date/Time
Text (15 char)

Description

Student ID (from Win School)

Medicare number

Height

Weigh

(Not used)

Immunization Status Code (see table below)

Immunization Status Description (see table

below)

Legal Alert Flag used in Win School
(1=Active, 0=Inactive)

Health module Medical Alert Flag
(1=Active, 0=Inactive)

Health module medical alert condition
Health module medical alert comment

Provisional Enrolment Flag (1=Active,
O=Inactive)

Provisional Enrolment Date

Last update date

Archive Flag (1=Active, 0=Inactive)
Archive Flag Date

User name
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Immunization Status

Code
1

o 9 o v A

Immunization Status Description

N/A

Religious Exemption

Parental Exemption

Medical Exemption

Military Exemption

Illness Exemption

Immunization Information Table IMDA_ImmunizationDataExport
This table contains the immunization record for each student from their

medical record, including immunization, action, and reaction.

Field

Index
ItemCode
TtemDesc
ActionCode
ActionDesc

Date

Time

Dosage

Nnote

LastUpdate
User
ReactionCode

ReactionDesc
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Data Type

Number (integer)
Number (long integer)
Text (30 char)
Number (long integer)
Text (30 char)
Date/Time

Date/Time

Number (double)

Memo

Date/Time

Text (15 char)
Number (long integer)
Text (30 char)

Description

Student ID (from Win School)

Immunization Code

Immunization Title

Action Code (see table below)

Action Description (see table below)

Date of the Immunization
assignment

Time of the Immunization
assignment

(Not used)

Immunization Assignment
Comment

Last update date
User name
Reaction code

Reaction Description



Immunization Action

Code
1

~N | N U AW

Immunization Action Description
N/A

Administered

Medical Exemption

Military Exemption

Parental Exemption

Religious Exemption

Illness Exemption

Examination Records Table EXRE_ExaminationRecordsExport
This table contains the examination records for each student from the
Examinations area in the student medical record, including examination title,
description, and exam code.

Field
Name

ExIndex
Student
Date
Age

Grade

TitlCode
TitlDesc
StatCode
StatDesc
CatCode
CatDesc
EX2Index
ExCdCode
ExCdDesc
User
LastUpdate

Data Type Description

AutoNumber (long integer) Examination internal index

Number (integer) Student ID (from Win School)
Date/Time Date of the examination

Number (integer) Student age at the time of examination

If student age is “N/A”, it is exported
as 7150071’ ”0", or"" (blank)

Text (3 char) Student grade at the time of
examination

Number (long integer) Examination title code

Text (29 char) Examination Title

Number (long integer) Examination Status Code

Text (29 char) Examination Status name

Number (long integer) Examination Category code

Text (29 char) Examination Category name

Number (long integer) Examination Code ID (code)

Text (29 char) Examination Code name

Memo Examination (Category) comment

Text (15 char) User name

Date/Time Date of examination
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Health Conditions Table HCOD_HealthConditionsExport
This table contains the Health conditions for each student from the
Conditions area in the student medical record, including condition level and

comments.

Field Data Type Description

Index Number Student ID (from Win School)
CondCode Text (4 char) Condition Code

CondDesc Text (29 char) Condition Name

LevelCode Text (4 char) Condition Level Code
LevelDesc Text (29 char) Condition Level Name

Date Date/Time Date of condition assignment
Com1Code Text (4 chat) Condition Comment code
Com1Desc Text (255 char) Condition Comment
Com2Code Text (4 char) Condition Comment code
Com2Desc Text (255 char) Condition Comment
Com3Code Text (4 char) Condition Comment code
Com3Desc Text (255 char) Condition Comment
Com4Code Text (4 char) Condition Comment code
Com4Desc Text (255 char) Condition Comment
Comment Memo Additional Comment

User Text (15 char) User name

LastUpdate Date/Time Last update date

Exporting to Excel

Exporting to Excel creates the HealthExport.xls workbook in the root folder
of drive C, which contains the following six spreadsheets:

LDOIN_LocalDoctorInformationExp DEIN_DentistInformationExport
HDDA_HealthDemographicDataExpor IMDA _ImmunizationDataExport
EXRE_ExaminationRecordsExport HCOD_HealthConditionsExport

Doctor Information Sheet LDOIN_LocalDoctorinformationExp
This spreadsheet contains the Doctor details for each student from their

Student Profile.

Column
Index
Name
OffPhone

HomePhone
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Description
Student ID (from Win School)
Doctor name
Doctor Office Phone number

Doctor Home Phone number



Column
Addrl
Addr2
City
State

Zip

Description
Doctor address1
Doctor address2
Doctor City
Doctor State

Doctor Zip

Dentist Information Sheet DEIN_DentistinformationExport

This spreadsheet contains the Dentist details for each student from their
Student Profile.

Column
Index
Name
OffPhone
HomePhone
Addrl
Addr2

City

State

Zip
LastUpdate

Description

Student ID (from Win School)
Dentist Name

Dentist Office Phone number
Dentist Home Phone number
Dentist Addressl

Dentist Address2

Dentist City

Dentist State

Dentist Zip

Last update date

Student Demographics Sheet HDDA_HealthDemographicDataExpor

This spreadsheet contains the student Health demographic data for each
student from their Student Profile.

Column
Index
Medicatre
Height

Weigh
StudentAid
ImmCode
ImmDesc
LegalAlertFlag
MedAlFlag
MedAlCond
MedAlComm
ProvEntFlag

Description

Student ID (from Win School)

Medicare number

Height

Weigh

(Not used)

Immunization Status Code (see table below)
Immunization Status Description (see table below)
Legal Alert Flag imported from Win School (True/False)
Health module Medical Alert Flag (True/False)
Health module Medical Alert condition

Health module Medical Alert Comment

Provisional Enrolment Flag (True/False)
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Column Description

ProvEnrDate Provisional Enrolment Date
LastUpdate Last update date

ArcFlag Archive Flag (True/False)
ArcFlagDate Archive Flag Date

User User name

Immunization Status
Code Immunization Status Description

N/A

Religious Exemption
Parental Exemption
Medical Exemption

Military Exemption

o e I e S e

Illness Exemption

Immunization Data Sheet IMDA_ImmunizationDataExport
This spreadsheet contains the immunization record for each student from
their medical record, including immunization, action, and reaction.

Column Description

Index Student ID (from Win School)
ItemCode Immunization Code

ItemDesc Immunization Title

ActionCode Action Code (see table below)
ActionDesc Action Description (see table below)
Date Date of the Immunization assignment
Time Time of the Immunization assignment
Dosage (Not used)

Nnote Immunization Assignment Comment
LastUpdate Last update date

User User name

ReactionCode Reaction code

ReactionDesc Reaction description
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Immunization Action

Code
1

~N | N U AW

Immunization Action Description
N/A

Administered

Medical Exemption

Military Exemption

Parental Exemption

Religious Exemption

Illness Exemption

Examination Records Sheet EXRE_ExaminationRecordsExport
This spreadsheet contains the examination records for each student from the
Examinations area in their medical record, including examination title,
description, and exam code.

Column
ExIndex
Student
Date
Age

Grade
TitlCode
TitlDesc
StatCode
StatDesc
CatCode
CatDesc
EX2Index
ExCdCode
ExCdDesc
User
LastUpdate

Description

Examination internal index
Student ID (from Win School)
Date of the examination

Student age at the time of examination
If student age is “N/A”, it is exported as "500", "0", ot
" " (blank)

Student grade at the time of examination
Examination title code
Examination Title

Examination Status Code
Examination Status name
Examination Category code
Examination Category name
Examination Code ID (code)
Examination Code name
Examination (Category) comment
User name

Date of examination
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Health Conditions Sheet HCOD_HealthConditionsExport
This spreadsheet contains the Health conditions for each student in the
Conditions area in their medical record, including condition level and

comments.

Column
Index
CondCode
CondDesc
LevelCode
LevelDesc
Date
Com1Code
Com1Desc
Com2Code
Com2Desc
Com3Code
Com3Desc
Com4Code
Com4Desc
Comment
User
LastUpdate
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Description

Student ID (from Win School)
Condition Code

Condition Name

Condition Level Code
Condition Level Name

Date of condition assignment
Condition Comment code
Condition Comment
Condition Comment code
Condition Comment
Condition Comment code
Condition Comment
Condition Comment code
Condition Comment
Additional Comment

User name

Last update date
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A
Access File, exporting 42
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B

Backup 5

Batch assigning 77
conditions 76
examinations 72
immunization 27, 57

Bitmaps, loading 8

Buttons
for reports 64, 70, 73, 74, 76
Main window 47
Medical Alert 47, 55, 59, 71, 75
Medical Information 46
Next and Previous 51
Tooltip 1

C
Chancery contact information 1
Comments
for conditions 4, 32, 75, 76
for examinations 71, 72
for immunizations 28, 58
Medical Comments 81
Compliant 65, 66, 69
See also Noncompliant.
Contacts 77, 80
viewing 34, 44, 49

D
Database
archiving records 5, 43, 44
setting up a connection 4, 7, 9, 10
updating 5, 12, 32, 33, 43
dBase file, exporting 41
Deleting 11
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examinations 30
immunization doses 15
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Delinquent 25, 67, 68, 69, 70
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Dentist information 12, 44, 49, 50, 51, 52
Directory
root 41
Doctor
can call 34, 52
Doctor information 33, 34, 44
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overwriting 12
setting up 12
viewing 44, 49, 50

E
Emergency data

viewing 47, 49, 50

Win School Emergency Contact 34
Exemptions 29, 50, 54, 61, 62, 65, 66, 67, 69, 78
Exporting 10, 37, 40

Access 42
ASCII 40
dBase 41
Excel 42
F
Finding 46

Flagged student records
archiving 42, 43
inactive 48
Folder organization 5
Forecast provisionally enrolled students 61
Fully compliant. See Compliant and Noncompliant.

G

Grace period. See Provisional Enrollment Petiod.
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H
Help, displaying online 1

1
Immunization 77, 78
alternate 17, 18, 22
exemption 29, 54, 61
incomplete 69
noncompliant 69
populations 4, 17, 18, 21, 22, 27, 79
provisional enrollment 4, 25, 27
reports 61
viewing 61
Importing 37,78
use templates 37
Win School data 5
Inactive student records
sorting 48
viewing 48
Incomplete 67, 68, 69
IP Address 8, 78

L
Legal Alert 34, 50, 51, 52, 55, 81

M
Magnifier 48, 71
Main window
searching 46
sorting 48
using 46
Medical Alert 34, 47, 51, 81
entering 54
viewing 50, 51, 55, 59, 71, 75
Medical information, viewing 44, 49
Multi-user
archiving 5

N
Naming
bitmap files 8
database file 4, 5
Network IP Address 8, 78
Noncompliant 67, 68, 69

o
Other software
exporting to 10, 40
formatting files to import 37
using data from 37
Overriding provisional enrollment 50, 53, 54
Overwriting
doctor information 12
immunization dose 28, 57, 58

Index

P

Password 10

Pictures of students, viewing 50, 56
Populating Health, planning when 5
Populations 4, 17, 18, 21, 22, 27,79

Provisional enrollment 4, 25, 27, 50, 51, 53, 61, 63, 67, 79

overriding 50, 53, 54

Provisional enrollment period 4, 6, 13, 25, 69, 70, 77, 79

R

Removing
alternate immunizations 25
archive files 45
condition comments 32
condition levels 32
condition titles 31
conditions 75
examinations 30
immunization doses 15
immunization reactions 16
immunization requirements 21
immunizations 15, 59
populations 22
user accounts 11

Reports
conditions 76
delinquent 69
examinations 73
forecast provisionally enrolled students 61
how totals are calculated 66
immunization 27, 61, 66, 79
incomplete 69
noncompliant 69
options 60
provisional enrollment 27, 63, 67, 69
running reports 10, 17, 19

S
School
connecting a database 4, 7, 9, 10
entering information 9
Searching for a student record 46
Security
access levels 10, 79
changing password 6, 11
changing the default password 7
setting up 6, 10, 11,79
Shift-F2 48, 71
Standards 3, 4, 5
Student records
archive 44, 49
immunization history 61
inactive 48
pictures 8, 47, 50, 56



populations 4, 17, 18, 21, 22, 27
searching 46
selecting and viewing 44, 46
sorting 406, 48, 54
updating 5, 32, 46, 79, 80
updating immunization 59
with asterisk 49
with flag 48
System Administrator responsibilities 3, 5, 7, 10, 32

T
Task checklist 5
Template 37
ASCII file 40
demogtaphic data 38
examination records 39
health condition records 39
immunization records 38
Tooltip
displaying 1

U
User account 10, 11, 34, 79

w
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